
Using animations
Each time you use CorelWEB.MOVE to create and publish Java Powered (TM) applets, a number of files are 
referenced in the Barista folder. When you publish an animation using Corel Barista, a Web page, or .HTM file, is 
created corresponding to the directory and filename that you originally specified for your page. If you save 
the .HTML file to a folder other than the Barista folder, the .CLASS files AR.CLASS, EFFECT.CLASS, LOADER.CLASS,
and WEBMOVE.CLASS must be copied to the new location before you can view your animation in a browser.

Referencing Files with Windows 95
To view your WEB.MOVE animation in a Web browser, click File, Publish to WEB.DESIGNER and enable the Copy 
Class Files check box. The appropriate files are automatically copied.

Referencing Files with Windows NT
To view your WEB.MOVE animation in a Web browser, copy the .CLASS files AR.CLASS, EFFECT.CLASS, 
LOADER.CLASS, and WEBMOVE.CLASS (located in the Barista folder on the CorelWEB.GRAPHICS SUITE CD-ROM) 
to the folder containing your WEB.MOVE .HTML file. If you choose File, Publish to WEB.DESIGNER in the 
WEB.MOVE application, simply enable the Copy Class Files check box. The appropriate files are automatically 
copied.

Referencing Files with Windows 3.x
To view your WEB.MOVE animation in a Web browser, load the .HTML file along with AR.CLASS, EFFECT.CLASS, 
LOADER.CLASS, and WEBMOVE.CLASS (located in the Barista folder on the CorelWEB.GRAPHICS SUITE CD-ROM) 
onto your system's server.

See Also
Inserting animations
Barista files
Publishing in the Java Programming Language (TM) with Barista



Working with Barista files
Corel Barista is a publishing technology that allows you to publish Web pages in the Java Programming Language
(TM). Publishing with Barista removes the limitations imposed by the Hypertext Mark-Up Language (HTML) while 
offering rich formatting options, advanced layout control, and improved graphic display. 
To gain an accurate understanding of Barista's publishing techniques and its relevance to the 
CorelWEB.GRAPHICS SUITE of applications, examine the following topics in the order that they appear:
Publishing with Barista
Barista class files
The Barista file structure
Creating and merging Barista files
See Also
Using animations
Publishing in the Java Programming Language with Barista
Viewing your Web pages



Publishing with Barista
Corel's Barista technology is a Java-based (TM) publishing technology that allows you to use your favorite Corel 
software to publish Web pages in the Java programming Language. This means that you can apply all of the 
features and layout control enjoyed by Corel products to your Web publications without being restricted by HTML
limitations. In addition to HTML features like hyperlinks, graphics and tables, pages published with Barista also 
benefit from rich formatting options, multi-column WYSIWYG display, and complex imagery.
When you publish your page using Corel Barista, a Web page, or .HTM file, is created corresponding to the 
directory and filename that you originally specified for your page. Next, a subdirectory with the same name is 
automatically created and stored with your output file. This subdirectory stores the necessary page contents.
To view an accurate representation of your page in a Web browser, you must place the Barista class files in the 
same directory as your Web page. (The Barista Class files were installed with your Corel application and placed 
in a program subdirectory called /Barista.)
Tip
· Keep all of your Barista output in a single directory on your Internet server or local hard disk so that you only 

need to copy the Barista classes once.
See Also
Barista class files
The Barista file structure
Creating and merging Barista files



Barista class files
Like other Java Applets, Barista uses special Java program files called .CLASS files, to provide the necessary 
publishing instructions for your page or document. Whenever a Barista page is viewed through a browser, 
the .CLASS files are downloaded with your page so that the browser will be able to correctly display the page and
any pages that follow. Class files can be downloaded once and reused during the same browsing session.
To view an accurate representation of your Barista document in a Web browser, the Barista class files must be 
located in the same directory as your .HTM file. Depending on your file storage techniques, this requires either:
· publishing your Web page to the Barista subdirectory installed with your software, or
· copying all the files contained in the Barista subdirectory to the location of your Web page output file. (Be sure

to copy the Barista directory, all subdirectories, and their contents.)

Special notes for Win 3.1 Users
Java .CLASS files are unique because their file extension is five characters instead of the maximum three 
recognized by the Windows 3.1 operating system. If you are a Windows 3.1 user, this means that you will not be 
able to view Barista output from your local computer and must first upload the .CLASS files to your Internet 
server for proper viewing.
To circumvent the 3-character file extension limitation with Windows 3.1, a special BARISTA.ZIP file, containing all
of the necessary .CLASS files has been installed with your Corel application software. Copy this .ZIP file and your 
Web page output files to your server and ask your Webmaster to unzip them in the same directory using WinZip 
or any other decompression utility that supports long file names. Instruct your Webmaster to place the unzipped 
files in the same directory as your Web page .HTM file.

Special notes for UNIX Servers
When copying Barista class files to a UNIX server be sure to maintain letter case. The UNIX system is case 
sensitive.
See Also
Publishing with Barista
The Barista file structure
Creating and merging Barista files



The Barista file structure
The following files and directories are required to run a Barista .HTML file:

Barista.class file VDoc.class file
down.gif file VPage.class file
downd.gif file VPanel.class file
downp.gif file VPopMenu.class file
IHandler.class file VSPanel.class file
nexth.gif file VToolbar.class file
nextn.gif file VWindow.class file
prevh.gif file ZStorage.class file
prevn.gif file ar.class file
Scroller.class file effect.class file
up.gif file loader.class file
upd.gif file webmove.class file
upp.gif file corel director

The corel directory, located within the Barista folder on your CorelWEB.GRAPHICS SUITE CD, contains four 
subdirectories that are also required to view a Barista file.
See Also
Publishing with Barista
Barista class files
Creating and merging Barista files



Creating and merging Barista files
Combining CorelWEB.DESIGNER's Web publishing features with CorelWEB.DRAW's Barista technology allows you 
to make rich graphics available to audiences around the world.

To create images and publish to Barista in CorelWEB.DRAW
1. Launch CorelWEB.DESIGNER and click Start a new Web page.
2. Click Tools, CorelWEB.DRAW.

The CorelWEB.DRAW application is launched from the main WEB.DESIGNER screen.
3. Create an image using the tools offered in the CorelWEB.DRAW menus and toolbars. Refer to the 

CorelWEB.DRAW online Help files for assistance.
4. Click File, Publish to Barista and save your file.
5. Copy the contents of the /Barista program folder (including all subfolders) to the same directory as your 

CorelWEB.DRAW image.
To merge Barista files with your WEB.DESIGNER documents

1. Click Insert, HTML File in the CorelWEB.DESIGNER menu
2. Locate the WEB.DRAW .HTML file that was created when you published your image to WEB.DESIGNER.

WEB.DESIGNER displays a black region where the file will be displayed.

3.Click Tools, Browser Preview or click .

See Also
Publishing with Barista
Barista class files
The Barista file structure



Publishing in the Java Programming Language (TM) with Barista
Optimal viewing of Barista pages over low-bandwidth access, relies on upgrades to the Java Programming 
Language that are expected within the upcoming year. Until that time, Barista technology is recommended for 
Intranet environments only. Consult http://www.corel.com for the latest information on the progress of these 
upgrades.
Corel's Barista Technology is based on Sun Microsystems Inc. publishing technology and allows you to use your 
favorite Corel page layout and illustration software as both a Java Powered creation and WYSIWYG authoring tool 
for the Internet. This means that you can enjoy all of the features and layout control available with Corel 
products when publishing to the Web, without being restricted by HTML limitations.
Support for the Java Programming Language is quickly becoming the de facto standard among browsers such as 
Netscape Navigator 3.0 and Microsoft Internet Explorer 3.0. As a result, JavaSoft, the creators of the Java 
Programming Language, and the browser industry are aggressively refining performance issues associated with 
the Internet. Barista was designed in anticipation of these refinements and requires improved compression, font 
support, and class downloading for optimal functioning. This means that as a Corel user, you will already have 
advanced technological capabilities built into your software when these enhancements are implemented.
In the meantime, we recommend that you use Barista in an Intranet environment only, where bandwidth is not 
as sensitive. This way, you can immediately discover the benefits of Barista and use the technology to its fullest 
potential as soon as browsers and the Java Programming Language itself implement the planned performance 
improvements.
Note
· The Java Programming Language is a platform independent language being widely adapted for the Internet in 

order to provide rich content to Web pages.

See Also
Barista files
Using animations
Publishing files to WEB.DESIGNER



Editing Web page elements
To create a page for display on the World Wide Web, you must insert a variety of Web page elements. These may
include images, horizontal rules, hyperlinks, forms, or tables.
You can edit the properties or change the characteristics of most HTML elements by double-clicking the element 
or by selecting it and clicking Edit, Properties. WEB.DESIGNER updates the changes you make to a selected 
element when you click OK or Apply in the appropriate dialog box. Choose View, Refresh Window if any distortion
occurs when updating a document or if your changes do not immediately take effect.
Refer to each Web page element for more information on editing options.
Notes
· Many Web elements have their own properties dialog boxes that can be used to change the feature's 

appearance and characteristics. For example, you can edit a table in your Web document by clicking Table, 
Table Properties and modifying the values specified in the Table Properties dialog box.

· To view your page as it will appear on the World Wide Web, click Tools, Set Browser and specify the directory 
path leading to the executable file of your preferred Web browser. For all subsequent previews click Tools, 

Browser Preview or . WEB.DESIGNER automatically loads your current page in the specified browser.

See Also
CorelWEB.DESIGNER introduction
The World Wide Web and HTML
Organizing files



Saving your work and exiting CorelWEB.DESIGNER
Before exiting the CorelWEB.DESIGNER application, you must save your work in your server root directory. If you 
have made changes to a file and attempt to exit without saving the document, WEB.DESIGNER prompts you to 
save the file. Click Yes to save your changes and exit the application. Click No to exit the application without 
saving your modifications. Click Cancel to return to the active CorelWEB.DESIGNER window.

To save changes to your Web page file
1. Click File, Save As.

WEB.DESIGNER opens the Save As dialog box.
2. Type a name in the File name field.

To exit CorelWEB.DESIGNER
· Click File, Exit.
Notes
· To maintain consistency and organization among Web files, save your pages inside your server root directory. If

you choose to save your Web page in another directory, outside the server root, all images and files 
referenced with relative addresses will be copied with the .HTML file. If necessary, folders will be created in the
new location to mirror the original directory structure.

· When naming your WEB.DESIGNER documents avoid the use of symbols. CorelWEB.DESIGNER does not 
recognize the percent or number sign symbols (%, #).

See Also
Saving Web pages
Organizing files



Specifying basic Web page properties
When designing your CorelWEB.DESIGNER documents, you can specify basic properties that affect the 
appearance and layout of the entire page. Setting the document title, specifying background images or color, 
and choosing text colors create more appealing, organized pages for your audience.

To change your document's title
1. Click File, Page Properties.

WEB.DESIGNER opens the Page Properties dialog box.
2. Type a name in the Document Title field.
3. Click OK.

To change your page's background color
1. Click File, Page Properties.

WEB.DESIGNER opens the Page Properties dialog box.
2. Choose a color from the Background Color list box.
3. Click OK.

To insert a background image
1. Click File, Page Properties.

WEB.DESIGNER opens the Page Properties dialog box.
2. Click the Browse button beside the Background Image Source field.

WEB.DESIGNER opens the Select Image Source dialog box.
3. Locate an image file and click Open.

WEB.DESIGNER returns to the Page Properties dialog box.
4. Click OK.
Note
· Because many World Wide Web search tools only scan the words displayed in your document's title, it's 

important to give your page a meaningful name.

See Also
Creating new Web pages
Editing Web page elements



Reversing the most recent action
Like most word processing packages, CorelWEB.DESIGNER allows you to undo or reverse your most recent 
action.

To undo your last action
· Click Edit, Undo.
Note
· You can also press CTRL+Z to undo your most recent action.

See Also
Edit menu



Adding and formatting Web page text
With CorelWEB.DESIGNER, you can add or delete text in the same way that you add or delete text in a standard 
word processing application. You can also copy and paste text or change the formatting of characters, words, 
and paragraphs in your WEB.DESIGNER documents.

To add text to a Web page
1. Position the cursor at the point in your WEB.DESIGNER document where you want to add text.
2. Type the text.

WEB.DESIGNER displays the text using the default Normal style and Default font.

To specify a different paragraph style 
1. Position your cursor in the line of text that you want to change.
2. Choose a paragraph style from the Text Styles list box.
CorelWEB.DESIGNER provides the following paragraph style options:
Style Description
Normal Default text formatting.
Heading 1- Heading 6 Corresponds to the HTML heading tags <H1> through <H6>. 
Preformatted Corresponds to the HTML <PRE> tag which displays text exactly as entered, in a 

monospace font that retains all line breaks and spaces.
Block Quotation Corresponds to the HTML <BLOCKQUOTE> tag, including paragraph breaks before 

and after the block quote tag and indentation for the quoted text.
Note
· CorelWEB.DESIGNER provides other HTML formatting options in the Style and Formatting toolbars and the 

Insert, Format, and Table menus.

See Also
Copying and pasting text from other applications
Formatting toolbar
Style toolbar
Insert menu
Format menu



Copying and pasting text from other applications
Web pages are often based on information created in other applications such as word processors. To avoid re-
typing text contained in external files, you can copy the original text and paste it into your CorelWEB.DESIGNER 
document.
The following options are available from WEB.DESIGNER's Edit menu:

Option Description
Copy [CTRL+C] Copies the selected text to the Clipboard. The Clipboard acts as a storage device 

from which the copied text can be retrieved.
Paste [CTRL+V] Pastes the copied text into your Web page at your current cursor location. This 

command is especially useful if you want to copy from an existing Web page or 
from another file. See Viewing and editing HTML Source.

Cut [CTRL+X] Cuts the selected text and places a copy in the Clipboard. Used with the Paste 
command, the WEB.DESIGNER cut feature can move text from one portion of a 
document or program to another.

Notes
· To paste HTML tagged text from the Clipboard into your Web page, you must paste into the HTML Source view.
· To open existing HTML pages, click File, Open.
· To merge an .HTML file with your open page, click Insert, HTML File.
· To convert word processing files from Corel WordPerfect, Microsoft Word, or Lotus AmiPro to HTML, click Tools, 

CorelWEB.Transit.

See Also
Adding and formatting Web page text
Edit menu
Standard toolbar
Converting word processing files
Merging .HTML files



Viewing and editing HTML Source
Although you usually don't view HTML tags when you use CorelWEB.DESIGNER to create your Web pages, each 
time you perform an operation you are actually creating HTML statements that can be interpreted and displayed 
by Web browsers. In fact, you can view and edit the HTML source code generated by CorelWEB.DESIGNER in the 
same way that you create and edit pages without a WYSIWYG editor. 

To view or edit the HTML code directly

1. Click Edit, HMTL Source or click .
CorelWEB.DESIGNER opens the Edit HTML Source window and displays the HTML statements that 

correspond to the WYSIWYG view of your current WEB.DESIGNER document.
2. Click Keep Changes to save your modifications and close the Edit HTML Source window or click Discard 
Changes to close the Edit HTML Source window without saving your changes.

If you choose Keep Changes, WEB.DESIGNER updates your screen and implements your modifications.
Note
· To view the latest changes you've made to your HTML Source code, you may need to click View, Refresh 

window.
See Also
HTML tag reference
Adding sound
Editing your favorite published pages
Edit menu



Adding sound
With CorelWEB.DESIGNER, you can add background sound to your Web pages by specifying Wave (.WAV), Aiff 
(.AIF, .AIFC, .AIFF), Au (.AU), or Midi (.MID) soundtracks in the Page Properties dialog box. You can also embed 
alternate sound file types in your Web pages using the Embedded File command or create standard hyperlinks 
that jump to sound files using the Hyperlink command.

Adding background sound
Embedding sound files
Linking to sound files

Notes
· Sound files that have been added using WEB.DESIGNER's background sound feature can only be played using 

Microsoft's Internet Explorer on systems that support the specified file type. The <BGSOUND> tag supports 
Wave (.WAV), Aiff (.AIF, .AIFC, .AIFF), Au (.AU), and Midi (.MID) files. Embedded sound can be played by both 
Internet Explorer 3.0 and Netscape Navigator 3.0.

· Midi files that have been added to Web pages using WEB.DESIGNER's background sound feature, cannot be 
played from the Select A Sound File dialog box on Windows 3.1 systems. Instead, you must add the 
background sound file and preview your page using Microsoft's Internet Explorer to play the file.

Tips
· You can embed or link to any sound file type but playing sound files depends on individual system 

components. To play sound files, you must have an audio player such as the Real Audio player which is 
accessible from the Real Audio Web site at http://www.prognet.com/products/player2.0.html. If a visitor to your
site clicks a hyperlink to a sound file but does not have the appropriate audio player installed on their system, 
they may save the sound file until a listening device is made available.

· To adjust the display of the embedded sound file controls in your Web page, resize the embedded file using the
spacing, alignment, and scaling properties in the Embedded File dialog box.

See Also
Creating hyperlinks
Viewing and editing HTML source
HTML tag reference



Adding background sound
With CorelWEB.DESIGNER you can create musical Web pages by adding a sound file to the Background Sound 
section of the Page Properties dialog box.

To add background sound to your Web page
1. Save the sound file that you've chosen for your Web page in your server root directory with your .HTML file.
2. Click File, Page Properties.

WEB.DESIGNER opens the Page Properties dialog box.
3. Click Browse.

WEB.DESIGNER opens the Select A Sound File dialog box.
4. Locate the sound file in your server root directory and click Open.

WEB.DESIGNER inserts the file in the Sound Source field of the Page Properties dialog box.
5. Type a value in the Loop box or enable the Non-Stop check box.

The loop value determines the number of times that the sound file plays when a visitor accesses your Web 
page. If you enable the Non-Stop check box, the sound file plays continuously while your Web page is active.

6. Click OK.
Notes
· Sound files that have been added using WEB.DESIGNER's background sound feature can only be played using 

Microsoft's Internet Explorer on systems that support the specified file type. The <BGSOUND> tag supports 
Wave (.WAV), Aiff (.AIF, .AIFC, .AIFF), Au (.AU), and Midi (.MID) files. Embedded sound can be played by both 
Internet Explorer 3.0 and Netscape Navigator 3.0 users.

· Midi files that have been added to Web pages using WEB.DESIGNER's background sound feature, cannot be 
played from the Select A Sound File dialog box on Windows 3.1 systems. Instead, you must add the 
background sound file and preview your page using Microsoft's Internet Explorer to play the file.

See Also
Embedding sound files
Linking to sound files



Embedding sound files
With CorelWEB.DESIGNER, you can embed any file, including sound files, in your Web pages using the Embedded
File command. WEB.DESIGNER adds an audio playing device to your document, that you can resize and adjust to
suit your page's structure and content.

To embed sound files in your WEB.DESIGNER document
1. Save the sound file that you've chosen for your Web page in your server root directory with your .HTML file.
2. Click Insert, Embedded File.

WEB.DESIGNER opens the Embedded File dialog box.
3. Click Browse.

WEB.DESIGNER opens your server root directory in the Select File dialog box.
4. Select the sound file and click Open.

WEB.DESIGNER returns to the Embedded File dialog box.
5. Adjust the spacing, alignment, or scaling of your embedded file and click OK.

WEB.DESIGNER inserts the sound file in your Web page.
Tip
· You can embed or link to any sound file type but playing sound files depends on individual system 

components. To play sound files, you must have an audio player such as the Real Audio player which is 
accessible from the Real Audio Web site at http://www.prognet.com/products/player2.0.html. If a visitor to your
site clicks a hyperlink to a sound file but does not have the appropriate audio player installed on their system, 
they may save the sound file until a listening device is made available.

See Also
Adding background sound
Linking to sound files



Linking to sound files
With CorelWEB.DESIGNER, you can create standard hyperlinks leading to sound files in your Web pages. Simply 
format text or objects as hyperlinks and specify the location of the sound file in the Hyperlink Properties dialog 
box.

To create a link to a sound file
1. Save the sound file that you've chosen for your Web page in your server root directory with your .HTML file.
2. Select the text or image that your visitors will click to play the sound file.

3. Click Format, Hyperlink or click .
WEB.DESIGNER opens the Hyperlink Properties dialog box.

4. Click Browse and navigate to your server root directory.
5. Select the sound file and click OK.

WEB.DESIGNER returns to the Hyperlink Properties dialog box.
6. Click OK.

Tip
· You can embed or link to any sound file type but playing sound files depends on individual system 

components. To play sound files, you must have an audio player such as the Real Audio player which is 
accessible from the Real Audio Web site at http://www.prognet.com/products/player2.0.html. If a visitor to your
site clicks a hyperlink to a sound file but does not have the appropriate audio player installed on their system, 
they may save the sound file until a listening device is made available.

See Also
Adding background sound
Embedding sound files



Saving Web pages
Before exiting the CorelWEB.DESIGNER application, you must save your work in your server root directory. If you 
have made changes to a file and attempt to exit without saving the document, WEB.DESIGNER prompts you to 
save the file. Click Yes to save your changes and exit the application, click No to exit the application without 
saving your modifications, or click Cancel to return to the active CorelWEB.DESIGNER window.

To save your Web Page
1. Click File, Save As.

WEB.DESIGNER opens the Save As dialog box.
2. Type a name in the File name field.
3. Click OK.

CorelWEB.DESIGNER displays your page's name in the title bar.
Notes

· Click File, Save or click  to save a file that has already been named.
· By default, Web pages are saved in the directory specified as your server root. You can change your server 
root by choosing Tools, Set Server Root and then navigating to the desired location. If you change your server root, 
restart your WEB.DESIGNER application to apply the new the setting.
· When naming your WEB.DESIGNER documents avoid the use of symbols. CorelWEB.DESIGNER will not 
recognize the percent or number sign symbols (%, #).
· We recommend that you save your Web page inside your server root. However, if you choose to save your 

Web page in a directory other than your server root, WEB.DESIGNER copies all referenced image files with 
relative addresses to that location. When necessary, folders will be created in the new location to mirror the 
original directory structure.

See Also
Standard toolbar
Saving your work and exiting CorelWEB.DESIGNER



Adding horizontal rules
With CorelWEB.DESIGNER, you can add horizontal rules to your Web pages and modify their appearance using 
the Horizontal Rule Properties dialog box.

To add a horizontal rule
1. Position your cursor on the line where you want to add a horizontal rule.

2. Click Insert, Horizontal Rule or click .
CorelWEB.DESIGNER adds a horizontal rule to your document.

3. Double-click the horizontal rule.
CorelWEB.DESIGNER opens the Horizontal Rule Properties dialog box.

4. Modify the height, width, alignment, or shading of the horizontal rule.
5. Click OK.

See Also
Standard toolbar



Adding bold, emphasis, and other character formats
Using CorelWEB.DESIGNER's Formatting and Style toolbars, you can enhance your Web pages with bold, 
emphasis, and other character formats.

To format bold text
1. Select the text you want to appear in bold type.

2. Click .
CorelWEB.DESIGNER displays the text in bold type, indicating that you’ve applied the <BOLD> HTML tag to

the selected text.
Notes

· You can also add bold emphasis by clicking  and typing the text.
· Follow the same procedure to add italic, emphasis, and other character formats to text, substituting the 
appropriate commands from the Formatting and Style toolbars.

See Also
Formatting toolbar



Creating ordered and unordered lists
CorelWEB.DESIGNER's list features allow you to format entire paragraphs of text as numbered or bulleted lists 
using the Format, Ordered List and Format, Unordered List commands. You can also create numbered or bulleted 
lists by clicking Insert, Ordered List or Insert, Unordered List and adding your list items.

To create a new list
1. Position your cursor on the line where you want to add a new list of items.
2. Click Insert, Ordered List or Insert, Unordered List depending on the type of list that you want to create.

CorelWEB.DESIGNER indents the first number or bullet on your Web page.
3. Type the first list item.
4. Press ENTER [key] to continue your list.
5. To finish the list, press ENTER [key] twice.

To create a list using existing text
1. Select the series of paragraphs that you want to format as a list.

2. Click  or 

 depending on the type of list that you want to create.
CorelWEB.DESIGNER displays the paragraphs you selected as items in a numbered or bulleted list.

To create a nested list
1. Place your cursor at the point in a ordered or unordered list where you want to add a nested list.
2. Click Insert, Ordered List or Insert, Unordered List, depending on the type of list that you want to create.
3. Type the text for each item in the list and press ENTER [key] after each.
4. Press ENTER [key] twice to return to the next item in your original list.

See Also
Insert menu
Format menu
Formatting toolbar



Spell checking Web pages
With CorelWEB.DESIGNER, you can spell check Web pages that you’ve created and correct any errors. You can 
also add new words, terms, or other items to a personal dictionary that supplements the standard 
CorelWEB.DESIGNER dictionary.

To perform a spelling check
1. Position your cursor at the top of your Web page.

2. Click Tools, Spelling Check or click .
CorelWEB.DESIGNER begins spell checking your Web page. If no errors are found, CorelWEB.DESIGNER 

displays the message "Spell Check completed. No errors found." Otherwise, it displays a dialog box, prompting you 
to specify how to resolve the spelling of suspect or misspelled words.

To correct misspelled Words
1. Type a replacement term in the Replace With field.
2. Click Change or Change All.

Clicking Change replaces the current instance of the suspect word. Clicking Change All replaces all instances 
of the term on your page.

3. Continue to review suspect words. 
4. Click Close to end the spell check and return to your active Web page.

CorelWEB.DESIGNER displays a message box, indicating the results and the number of corrections made to 
your work.

Notes
· When CorelWEB.DESIGNER locates a word that is not in the standard or personal dictionaries, it selects the 

suspect word and generates a list of suggestions or alternate terms. You can replace a suspect word with one 
of the suggested words, type a unique replacement, or ignore the error.

· If the suspect word is spelled correctly, you can click Ignore or Ignore All, or you can click Add to Personal to 
add the new word to your personal dictionary. Press ENTER [key] to proceed without making any changes.

See Also
Tools menu
Saving your work and exiting CorelWEB.DESIGNER
Finding and replacing text
Saving Web pages



Creating hyperlinks
Even after years of advancement, hyperlinks remain the foundation of the World Wide Web, providing a fast and 
efficient means of navigating to precise information points. By clicking a hyperlink, you can jump to a different 
Web page or to a new point on the same Web page.
Each time you specify a hyperlink's destination or target reference in the Hyperlink Properties dialog box, you 
must include the file type or protocol. To link to another World Wide Web site, preface the URL with the http 
protocol (http://). To create an email link, preface the address with the mail protocol (mailto://). To link to a 
newsgroup, preface the USENET name with the news protocol (news:).

Additional protocols include
file:// Internet protocol used to link to a file on a local disk.
ftp:// Internet protocol used to exchange files by linking to an ftp site.
gopher:// Internet document retrieval protocol used to link to a menu-based gopher site.
telnet Internet protocol used for sharing information across multiple networks.
WAIS Internet textual database protocol used to link to a WAIS server.
If you don't know the URL that you want to specify for a hyperlink target, try searching for it on the World Wide 
Web. Complete Internet addresses appear in the Location field at the top of your Web browser's screen. 
Specifying URLs in this manner is a great way to make use of the WEB.DESIGNER copy and paste features.
Notes
· Creating internal links (links that jump to a new point on the same Web page) requires bookmarks. Bookmarks 

target the jump's destination by tagging a word or phrase.
· You can define hyperlinks for regions of an image by creating an image map (double-click the image and 

choose Image Map from the Image Properties dialog box).
· If you are referencing a Web site that resides on a UNIX server, verify the case of each of your hyperlink URLs. 

The UNIX file system is case sensitive.

See Also
Adding, editing, and removing hyperlinks
Using bookmarks within a document
Removing bookmarks
Creating image maps
Adding image map hyperlinks



Adding, editing, and removing hyperlinks
Hyperlinks distinguish hard-copy publications from online documentation, promoting a three dimensional 
approach to information design. CorelWEB.DESIGNER simplifies the construction of hyperlinks with toolbar 
buttons and dialog boxes, allowing you to mobilize the text and images displayed throughout your document.

To add a hyperlink to a Web page
1. Select the text or image that you want to format as a hyperlink.

2. Click Format, Hyperlink or click .
CorelWEB.DESIGNER opens the Hyperlink Properties dialog box.

3. Type the link's destination URL or click Browse and navigate to the hyperlink's target.
CorelWEB.DESIGNER displays your selected text or image as a hyperlink, shown underlined to indicate to 

users that the selection provides a link to another Web page or URL.

To change a hyperlink
1. Double-click the hyperlinked text or object.

WEB.DESIGNER opens the Hyperlink Properties dialog box.
2. Modify the destination URL displayed in the URL of Hyperlink field.
3. Click OK.

To remove a hyperlink
1. Select the hyperlinked text or object.

2. Click Format, Hyperlink or click .
Note
· To access a text and image resource, you need to preface the URL with the Hypertext Transfer Protocol (http) 

reference, e.g., http://myURLaddress. To link to the Corel Home Page, type http://www.corel.com. To link to an 
email address such as myfriend@corp.com, type mailto:myfriend@corp.com. To link to a newsgroup such as 
rec.gardening, type news:rec.gardening.

See Also
Using bookmarks within a document
Removing bookmarks
Creating image maps
Adding image map hyperlinks



Using bookmarks within a document
A bookmark codes and identifies a specific location within a WEB.DESIGNER document. Once you have set a 
bookmark, you can create a hyperlink to the bookmark's location. For example, you can construct a hyperlinked 
table of contents that jumps to a bookmarked section further in the same document.
You can create a bookmark for any text string or image by selecting the item and formatting your selection using
the Bookmark command in the Format menu. This procedure makes the new bookmark available to all hyperlinks
created within the document.

To create a bookmark
1. Select the target text or image.
2. Click Format, Bookmark.

WEB.DESIGNER opens the Bookmark dialog box.
3. Type a name in the Bookmarks field.

To link to a bookmark
1. Select the text or image that you will use as a hotspot for the jump.

2. Click Format, Hyperlink or click .
WEB.DESIGNER opens the Hyperlink Properties dialog box.

3. Click the Bookmark tab.
4. Choose a bookmark from the Bookmark list.
5. Click OK.

Notes
· To avoid confusion and destination errors, create a bookmark name that is memorable and that identifies the 

target location.
· Enabling the Bookmark command in the View menu causes all bookmarks in your WEB.DESIGNER document to

be marked with a color that you choose from the Page Properties dialog box in the File menu. The bookmark 
color specification will not show up in a browser window and can be toggled on or off with the Bookmarks 
command in the View menu. WEB.DESIGNER's default bookmark identification color is red.

See Also
Removing bookmarks
Creating hyperlinks
Format menu



Removing bookmarks
Once you have labeled a link's target or destination with a bookmark, you can always remove the specification 
from the Bookmarks list.

To remove a bookmark
1. Select the bookmark.
2. Click Format, Bookmark.

WEB.DESIGNER warns you that you are about to remove the bookmark formatting from the current selection.
3. Click Yes.
Notes
· To indicate that text is currently bookmarked, the Bookmark command in the WEB.DESIGNER format menu is 

displayed with a checkmark beside it. Once you have removed the bookmark from the text, the checkmark 
disappears.

· Removing a bookmark attribute causes all relative links to that bookmark to become non-functional but does 
not remove the hyperlink formatting from your page.

See Also
Using bookmarks within a document
Creating hyperlinks
Format menu



Creating new Web pages
Using CorelWEB.DESIGNER, you can create your own Web pages from scratch or base your design on a template.
To begin building your Web page from a new WEB.DESIGNER window, click File, New. Once you save your page, 
the title bar will display the corresponding file name. To begin building your Web page with one of 
WEB.DESIGNER's pre-designed templates, click File, Templates. Choose a sample page from the Templates folder 
and modify its elements to create your own customized document.

To start a new blank Web document
· Click File, New.

To start a new Web document based on a template
1. Click File, Templates or press CTRL+T.

WEB.DESIGNER opens the Choose Web Page Template dialog box.
2. Select a template and click Open.

WEB.DESIGNER opens the template file in the active window.
3. Modify the selection to display your site’s personal information.
Notes
· To simplify this introductory process, CorelWEB.DESIGNER offers a welcome message that lists all of the 

options available to you at the startup point. To enable/disable this message, choose Tools, Options.
· The first page that visitors see when they access a multi-page Web site, and the first page that most novice 

Web authors create, is a home page. In addition to providing a "front door" to a company or organization that 
maintains a site on the Web, a home page provides jumps or hyperlinks to all other resources and points of 
interest contained within an archive.

See Also
Splitting or opening a new document window
Specifying basic Web page properties
Editing your favorite published pages



Re-enabling the welcome screen
If you disable the Welcome to CorelWEB.DESIGNER screen, you can always re-enable the message by modifying 
the options displayed in WEB.DESIGNER's Options dialog box. 

To re-enable the welcome screen
1. Click Tools, Options.

WEB.DESIGNER opens the Options dialog box.
2. Enable the Display Welcome Screen On Startup check box.
3. Click OK.

See Also
Creating new Web pages
Splitting or opening a new document window



Finding and replacing text
You can use WEB.DESIGNER's Find and Replace capability to locate particular words and specify substitutions. 
This feature is particularly useful if you want to locate all instances of a word, term, or expression in a file.

To find words
1. Click Edit, Find. 

CorelWEB.DESIGNER displays the Find dialog box.
2. Type the word or phrase you want to locate in the Find What field.
3. Enable the Match Case check box to locate only those words that match the exact spelling and case of the 

specified term.
4. Click Find Next.

CorelWEB.DESIGNER searches your Web page and selects the first instance of the specified term.

To find and replace words
1. Click Edit, Replace or press CTRL+H.

CorelWEB.DESIGNER opens the Replace dialog box.
2. Type the word or phrase you want to find in the Find What field.
3. Enable the Match Case check box to locate only those words that match the exact spelling and case of the 

specified term.
4. Type a replacement term in the Replace With field.
5. Click Find Next.

CorelWEB.DESIGNER searches your Web page and selects the first instance of the specified term.
6. Click Replace to replace a single instance of the term or click Replace All to replace every instance of the 

specified term on your Web page.
Note

· You can also open the Find dialog box by pressing CTRL+F or by clicking  on the WEB.DESIGNER screen. 
You can open the Replace dialog box by pressing CTRL+H.

See Also
Edit menu
Adding and formatting Web page text
Spell checking Web pages



Splitting or opening a new document window
The CorelWEB.DESIGNER Split and New Window commands make working with Web pages easy. The Split option 
lets you partition the display of a single window to view more than one portion of the same Web page at the 
same time. The New Window option creates and opens multiple windows, allowing you to edit numerous Web 
pages simultaneously. These features are useful if you are editing or updating long Web pages or if you want to 
copy and paste text and images between Web pages.

To split the current Web page window display
1. Click View, Split. 

CorelWEB.DESIGNER displays a horizontal split bar.
2. Move your mouse to position the split bar on your screen.
3. Left-click or press ENTER [key].

CorelWEB.DESIGNER displays your Web page in the two panes separated by the split bar. You can navigate 
independently in each pane and cut, copy, and paste text or other information from one pane to the other.

To open a new document Window
1. Click View, New Window.

CorelWEB.DESIGNER opens a new, untitled window.
2. Click File, Open to open an existing HTML document.

See Also
Editing Web page elements
Creating new Web pages
View menu



Search For Help On

Opens the CorelWEB.DESIGNER help index, allowing you to search the online help system using keywords or 
phrases.



Organizing files to work locally and on the server
The Web pages that you create with CorelWEB.DESIGNER will be placed on a server for Internet users to access. 
Your service provider or Webmaster assigns a directory on the server to store your files. To ensure a seamless 
transfer of files from your machine to the server, we recommend that you emulate the server's directory 
structure on your local system.
CorelWEB.DESIGNER helps you mirror the server structure by instructing you to set a server root. Ideally, this 
root has the same name as the directory your files reside in on the server. For example, if all your pages reside in
the server directory /USER, you should set up a directory called USER on your hard drive and set the document 
root to be the same.

Working with subdirectories
You can have subdirectories working off of your root directory to help organize your files. For example, you may 
want to have a subdirectory called /IMAGES that will contain all your .GIF and .JPG files. (Check with your service 
provider to see if this will be acceptable.) If you decide to set up subdirectories, there are some important points 
to consider.
In order to test your pages locally, file references should be relative to the current page. For example, if you link 
to an image called LOGO.GIF in the subdirectory IMAGES, the hyperlink would refer to /IMAGES/LOGO.GIF. You will
not have problems viewing this locally with your browser or viewing it on the server, since the image is located 
in a subdirectory of the HTML file.

Working with common directories
File references outside of the root directory may not work when you test your page locally with a browser. For 
example, your organization may require you to access common images, like logos, from a central directory 
outside of the root. You can either use a substitute file locally to view a more accurate representation of your 
page structure (you must fix the reference when you place it on a server), or you can reference the image 
correctly as if your file was already on the server, but you will not see the image when you view it locally.

See Also
CorelWEB.DESIGNER introduction
The World Wide Web and HTML
Editing Web page elements



Editing your favorite published pages
With the CorelWEB.GRAPHICS SUITE, it's relatively easy to construct complex HTML elements and produce 
attractive Web sites. However, CorelWEB.GRAPHICS SUITE also allows you to import and edit most pages 
currently appearing on the World Wide Web.

To open a published page in WEB.DESIGNER
1. Click File, Open.

WEB.DESIGNER opens your server root directory in the Open dialog box.
2. Select an HTML file.

As CorelWEB.DESIGNER loads the document into the working window, it scans the underlying HTML Source 
code for the page and presents an HTML Parser Error dialog box that lists and corrects all of the HTML coding 
errors located within the file.

3. Edit the text and style of your imported page and insert images in the designated areas.
Notes
· To open a page from the World Wide Web, you must first save the Web page in .HTM or .HTML format. Click 

File, Save As in your browser and locate your server root directory.
· Saving files in .HTML or .HTM format from your browser window does not save the images referenced in those 

files. Instead, you must individually save each image by right-clicking the graphic in your browser window and 
choosing the Save As command from the pop-up menu. This allows you to include images from a variety of 
WWW sites in your final Web page.

· Although copyright policy on the World Wide Web remains vague, remember that a Web page or archive 
represents your personal presence on the Web and should never completely replicate another artist’s work.

See Also
Setting up a browser
Viewing and editing HTML source
Editing Web page elements
Creating new Web pages



Shortcuts
F7
Performs a spell check on the current document.

F12
Launches a browser directly from the WEB.DESIGNER window, allowing you to preview the current document on 
the World Wide Web.

F3

Activates the search specified in the Find dialog box.

BACKSPACE
Removes the last typed character or image.

CTRL+N
Opens a new WEB.DESIGNER window.

CTRL+O
Opens your server root directory in the Open dialog box.

CTRL+T
Opens the Templates dialog box, allowing you to create a new Web document from a pre-designed template.

CTRL+S
Saves the current WEB.DESIGNER document.

CTRL+P
Opens the Print dialog box, allowing you to print the current Web document.

CTRL+Z
Reverses the most recent action performed in the WEB.DESIGNER window.

CTRL+SHIFT+Z
Reverses the action performed by the Undo command.

CTRL+X
Removes the selected data from your document and copies it to the Clipboard. The selected text replaces any 
previous Clipboard contents.

CTRL+C
Copies selected data to the Clipboard, replacing any previous Clipboard contents.

CTRL+V
Adds a copy of the Clipboard contents to your Web document at the current cursor location.

Del
Deletes the selected text or object without copying it to the Clipboard.

CTRL+A
Selects the contents of your current Web page.

CTRL+F
Opens the Find dialog box, allowing you to search for text and other Web page elements including, fonts, styles, 
and special characters.

CTRL+H
Opens the Replace dialog box, allowing you to replace a search string with alternate text or objects.

CTRL+W
Opens a new CorelWEB.DESIGNER window, allowing you to view multiple HTML pages simultaneously.



CTRL+R
Refreshes the WEB.DESIGNER screen.

ENTER
Inserts a blank space and moves your cursor to a new line on the WEB.DESIGNER screen (hard return).

SHIFT+ENTER
Moves your cursor to a new line on the WEB.DESIGNER screen (soft return).
See Also
CorelWEB.DESIGNER menus
Using toolbars
HTML tag reference



Document Tree dialog box
Displays the hierarchical structure of your Web page and the HTML tags that are applied to text and other 
objects in your current WEB.DESIGNER document. The text affected by the HTML code appears between the 
opening and closing HTML container tags, e.g., <P>text</P>.
You can expand or collapse the display of embedded tags on a Web page by clicking the  or 
 key next to the HTML code.

Indicates that you can expand the display to show additional text, objects, and HTML tags.
Indicates that all embedded tags are currently displayed.

Notes
· The Document Tree dialog box displays a read-only view of your WEB.DESIGNER document. You cannot edit or 

modify your Web pages in the Document Tree.
· Image maps are not explicitly referenced in the Document Tree. Instead, you will see an <A HREF> reference 

to the .MAP file you created, along with the image source, below the opening HTML <BODY> tag. If you insert 
an .HTML file containing an image map in your current document, WEB.DESIGNER references the image map 
file outside of the </HTML> tag at the bottom of the Document Tree.



Horizontal Rule Properties dialog box
Specifies the properties of a horizontal rule, including its height, width, alignment, and shading. When you finish 
modifying these properties, click OK to save your changes and exit, or click Cancel to exit without saving your 
modifications. The Apply button implements the changes you've made without closing the dialog box.

Height Properties
Browser Default Specifies the standard height of a rule (dependent on your browser).
Pixels Specifies the height of the rule in pixels.

Width Properties
Browser Default Specifies the standard width of a rule (dependent on your browser).
Pixels Specifies the width of the rule in pixels.
% of Page Width Specifies the width of a rule as a percentage of the page width.

Alignment Properties
Browser Default Specifies the standard alignment of a rule (dependent on your browser).
Left | Center | Right Aligns the rule to the left, center, or right of the page.

Shading Properties
Browser Default Specifies the standard line shading of a rule (dependent on your browser).
Unshaded Specifies an unshaded horizontal rule.



Select File dialog box
Merges an existing .HTML file into your open Web page. With the Select File dialog box, you can search the 
drives, directories, and folders of your local system and locate a file to insert in your current WEB.DESIGNER 
document. This dialog box functions much like the Open dialog box in Windows 95, providing buttons to control 
new folders, file appearance, and movement among drive levels. Locate the .HTML file you wish to insert in your 
WEB.DESIGNER document by expanding the folders listed in the main window of the dialog box. Once you have 
chosen a .HTML or .HTM file, the name will appear in the File Name field.

File Name
Identifies the file that you want to open. By default, the Select File dialog box lists files with the .HTML or .HTM 
extension.

Files of Type
Specifies the file format that is displayed in the main area of the Select File dialog box. WEB.DESIGNER 
automatically filters your system's files, displaying only .HTM and .HTML file types.

Look in
Lists the drives and directories on your system, allowing you to search locally for a particular file.
Note
· WEB.DESIGNER inserts the .HTML file at your current cursor location.



Image Properties dialog box
Adds an image to your Web document. If the image is not located in the server root directory or in the same 
directory or a subdirectory of your .HTML file, WEB.DESIGNER prompts you to copy the image to the appropriate 
reference location.

Image Source
Identifies the location of the image that you want to add to your WEB.DESIGNER document. You can choose 
a .JPG, .GIF, .BMP, .TGA, or .PCX file. WEB.DESIGNER supports .GIF and .JPG file types directly and will 
convert .BMP, .TGA, and .PCX files to .GIF or .JPG format.

Alternate Text
Specifies text to replace the image in cases where the graphic file cannot be displayed (due to availability 
problems or display restrictions).

Alignment
Specifies the alignment of an image on your WEB.DESIGNER page.

Border Thickness
Browser Default Assigns a default border thickness to your image.
Zero Border Removes the border from your image.
Custom Thickness Specifies a border width in pixels.

Horizontal Spacing
Browser Default Assigns a horizontal spacing default to your image.
Custom Spacing Specifies a horizontal spacing value in pixels.

Scaling
Scale Width Scales the image width when enabled.
Custom Width Specifies the scale in pixels.
Scale Height Scales the image height when enabled.
Custom Height Specifies the scale in pixels.

Vertical Spacing
Browser Default Assigns the current vertical spacing default.
Custom Spacing Specifies the vertical spacing of your image in pixels.
Note
· To create an inline image, double-click the image and choose the Hyperlink tab in the Image Properties dialog 

box. Specify the destination URL for the image and click OK.



Image Map Properties dialog box
Identifies an existing image map file or creates a new image map file, allowing you to project multiple hyperlinks 
onto defined regions of an image. 

Use Image Map
Specifies an image map file to associate with the image on your current WEB.DESIGNER page.

Server Side Image Map URL
Specifies an existing image map file. Type the .MAP file's URL or click Browse to locate the file on your system.

Client-Side Image Map URL
Indicates whether the image map can be processed as a client-side image map. Client-side image maps work by 
placing a complete representation of the image's active areas (including their shape, size, and destination URL) 
into an SGML-compliant textual form. When you save your image map as server side, WEB.DESIGNER 
automatically gives the image a client side name in the Client-Side Image Map URL field.

Edit Map
Opens the specified image map file for editing.

Create Map
Opens the selected image in the Image Map Editor window, allowing you to create a new image map file.



Image Map Editor dialog box
Defines the hyperlink areas for an image map file. To create an image map file, define a region of the image and 
specify the URL that users will jump to when they click the hyperlinked area in a Web browser.

Element
Indicates the shape of a hyperlinked area within an image. Default (background) is displayed for areas of an 
image where no hyperlink is defined. 
Target URL
Specifies the destination URL for a hyperlinked area. To link to a file that resides on your local system, click 
Browse and navigate to the appropriate directory.
Comment
Allows you to label a particular hyperlinked area and its corresponding URL.

Browse 
Allows you to navigate to a file that you want to associate with a hyperlinked image area or region.
Tool Shapes
Specifies the boundaries of a hyperlinked area.
Save
Displays the Save As dialog box prompting you to specify where you want to save your new image-map file 
(NCSA compliant). A client-side image map is also created.



Page Properties dialog box
Specifies an image (.JPG or .GIF) to use as the background for your Web page or specifies a default background 
color. You can also specify the document title, background sound, and text colors in the Page Properties dialog 
box.

Document Title
Specifies a document title which is displayed in a browser's title bar on the Web.

Customize Background
Background Image Source Specifies the location of the image that you want to use as your background, 

relative to your server root directory. Click Browse to navigate directly to your 
background image's location.

Background Color Changes the background color. Choose a color from the Background Color list box. 
To return to the default color setting, choose the Default option. To specify a 
Custom color, choose the Custom command. WEB.DESIGNER specifies white as 
the default background color.

Background Sound
Specifies a sound file that plays when a visitor accesses your Web page on the World Wide Web. The background
sound loop value determines the number of times that the file plays when a visitor accesses your Web page. If 
you enable the Non-Stop check box, the sound file plays continuously while your Web page is active. Background
sound can only be played by browsers that have sound capability.
Customize Text Colors
Specifies the color of regular text, normal hyperlinks, visited hyperlinks, active hyperlinks and bookmarks on 
your Web page. To change the color of a text item, click the  button next to the current (or default) color 
setting. CorelWEB.DESIGNER allows you to choose between ten standard colors, to reset the default color setting
(by choosing the Default option), or to specify a Custom color by choosing the Custom option.
Note
· If you choose Custom when specifying background or text colors, CorelWEB.DESIGNER opens the Color dialog 

box, allowing you to choose a custom color setting for the text or item that you have selected.



Button Properties dialog box
Allows you to customize the appearance of your form's buttons. After making changes, click OK to exit and save 
your modifications or click Cancel to exit and restore properties to their original settings. The Apply button 
implements the changes you've made without closing the dialog box.

Name
Assigns a name to the button. This name will be used by the CGI script that processes your form's data.

Type
Submit form contents to URL Formats the button to perform a submit operation, sending the form's contents to 

the URL of the CGI program that you specified in the Form Action Handler.
Reset form with default values Formats the button to perform a reset operation, resetting the form’s field 

entries to their default values.

Button Label
Specifies the text that you want to appear on the button label.



Check Box Properties dialog box
Allows you to customize the appearance of your form's check boxes. After making changes here, click OK to exit 
and save your modifications or click Cancel to exit and restore properties to their original settings. The Apply 
button implements the changes you've made without closing the dialog box.

Name
Assigns a name to the check box. This name will be used by the CGI script that processes your form's data.

Initial State
Checked Enables the check box by default.
Unchecked Disables the check box by default.

Value sent when checked
Specifies the value sent by the form when the check box is checked.



Radio Button Properties dialog box
Allows you to customize the appearance of your form's radio buttons. After making changes here, click OK to exit
and save your modifications or click Cancel to exit and restore properties to their original settings. The Apply 
button implements the changes you've made without closing the dialog box.
Name
Assigns a name to the radio button. This name will be used by the CGI script that processes your form's data.

Initial State
Selected Enables the button by default.
Unselected Disables the button by default.

Value sent when button selected
Specifies the value sent by the form when the radio button is selected.



List Properties dialog box
Allows you to customize the appearance of your form's selection list or menu. After making changes here, click 
OK to exit and save your modifications or click Cancel to exit and restore properties to their original settings. The
Apply button implements the changes you've made without closing the dialog box.

Name
Assigns a name to the selection list or menu. This name will be used by the CGI script that processes your form's
data.

Type
Drop-down Menu Formats the form element as a drop-down menu.
List Box Formats the form element as a list box. If enabled, you can also specify the height 

of the list and indicate whether users may choose multiple items.

Contents
Item label Lists the items that will appear in your form's drop-down menu or list box.
Add Adds an item to the menu or list box.
Modify Allows you to edit an item in the drop-down menu or list box.
Remove Removes the selected item from the menu or list box.
Note
· You can specify the text displayed, the value returned, and the initial state of each item in the menu or list.



Text Field Properties dialog box
Allows you to customize the appearance of your form's text field. After making changes here, click OK to exit and
save your modifications or click Cancel to exit and restore properties to their original settings. The Apply button 
implements the changes you've made without closing the dialog box.

Name
Assigns a name to the text field. This name will be used by the CGI script that processes your form's data.

Type
Single Line Creates a single line text field for your form.
Multi Line Creates a multi line text field for your form.
Password Field Creates a password text field for your form.

Size
Character Width Specifies the number of characters that appear in the text field.
Maximum Length Specifies the maximum number of characters that the text field stores.

Initial Value
Specifies a default value that appears in the text field when the form is displayed.



Hyperlink Properties and Form Properties dialog boxes
Hyperlink Properties dialog box

Specifies the Uniform Resource Locator (URL) of your hyperlink's destination or target. Hyperlinks on Web Pages 
allow you to quickly navigate to the information or locations that you're interested in. By clicking a hyperlink, you
can jump to a different Web page and access entirely new information. Using CorelWEB.DESIGNER, you can 
easily create hyperlinks from text blocks or images displayed on your Web page.

Hyperlink
URL of Hyperlink Specifies the destination URL of the hyperlinked text.

Bookmark
Bookmarks Lists the bookmarks that you have formatted in your current WEB.DESIGNER 

document.
Notes
· To link to a World Wide Web site, type the page's URL in the URL of Hyperlink area. To link to a file on your local

server, click the Browse button and locate the file.
· To link to a bookmark, click the Bookmark tab and choose a bookmark from the Bookmarks list box.
Form Properties dialog box

Holds the Form Action Handler and identifies the URL of the CGI Script that monitors your form's input and 
generates the appropriate output. Type the file location relative to your server root directory or click the Browse 
button to navigate directly to the CGI Script.

Form Action Handler
URL of CGI Script Specifies the URL of the CGI script that processes the input submitted from your 

form.
Note
· When a visitor to your Web page submits a form, the information is sent to your server. The CGI Script you 

specify in the Form Action Handler dialog box determines how that information is handled by the server. For 
more information on the setup and use of CGI Scripts, consult your Webmaster.



Link to Bookmark dialog box
Allows you to choose a bookmark as the destination or target of a hyperlink in the same WEB.DESIGNER 
document. Bookmarks in Web Pages allow you to quickly navigate to information that you're interested in. By 
clicking a bookmark link, you can jump to a different location on the current Web page. Using 
CorelWEB.DESIGNER, you can create standard hyperlinks from text blocks or images to a bookmark that lies in a 
different area of your Web page.

Bookmarks
Lists the bookmarks that you have formatted in your current WEB.DESIGNER document.
Note
· To link to a bookmark, click the Bookmark tab and choose a bookmark from the Bookmarks list box.



HTML Parser Error
Detects invalid HTML statements in your Web page. Most often, error statements occur if you have incorrectly 
edited the HTML Source for your Web page or if you have merged files using tags that are not supported by 
CorelWEB.DESIGNER. Record the line numbers and errors reported in the Parser Error, then click Edit, HTML 
Source to open your Web page document and edit the invalid statements.
Although some browsers may display a parser that contains incomplete coding or non-strict coding, 
CorelWEB.DESIGNER follows strict HTML tag regulations and identifies all irregular tag forms as errors.
Note
· The WEB.DESIGNER HTML Parser Error attempts to resolve coding errors for you. For example, if opening tags 

are found within your HTML document without their closing tags, such as a <TABLE> tag without the 
</TABLE> tag, WEB.DESIGNER automatically closes the tag for you.



HTML Source window
Displays the HTML statements that correspond to WEB.DESIGNER's WYSIWYG presentation of your Web page. 
You can edit your WEB.DESIGNER documents by modifying the HTML code displayed in the Edit HTML Source 
window.

Keep Changes
Exits the HTML Source display and applies your changes to the current WEB.DESIGNER document. You may have 
to click View, Refresh Window to view an accurate representation of your page.

Discard Changes
Exits the HTML Source display without saving the changes that you made to your Web page. The Discard 
Changes option restores your document to its original state.

Print Source
Prints the HTML sequences displayed in the HTML Source window.
Note
· To paste HTML tagged text from the Clipboard into your Web page, you must paste into the HTML Source 

window.



Spell Check dialog box
Checks the spelling of all text on your current WEB.DESIGNER document. If CorelWEB.DESIGNER finds a word 
that is not in its dictionary, it generates a list of substitute terms. You can pick one of the WEB.DESIGNER 
suggestions and click Change or Change All to replace the error or click Ignore or Ignore All to bypass instances 
of the suspect word.

Word not in dictionaries
Displays the suspect word or term.

Change to
Displays the replacement word or term.

Suggestions
Displays a list of suggested replacements for the suspect term, generated from the WEB.DESIGNER dictionary 
and your personal dictionaries.

Ignore
Ignores the current instance of a suspect word.

Ignore All
Ignores all instances of the suspect word on your Web page.

Change
Replaces the current instance of a suspect word with one of CorelWEB.DESIGNER's suggested terms or a 
customized replacement.

Change All
Replaces all instances of the word on your Web page with one of CorelWEB.DESIGNER's suggested terms or a 
customized replacement.

Add to Personal
Adds a suspect word to your personal dictionary for use in subsequent spelling checks. 

Close
Ends the spelling check and displays the results.



Server Root dialog box
Specifies a directory that will store your .HTML files and provides the base location from which 
CorelWEB.DESIGNER resolves relative URLs to image files and other hyperlinked documents. 

Server Root
Specifies the directory location that stores all of the .HTML files and referenced objects used in your 
WEB.DESIGNER documents. Type a precise directory path or click the Browse button to search your local system 
for the appropriate directory.
Note
· After changing your server root directory, restart WEB.DESIGNER to apply the setting.



Select the Server Root Directory dialog box
Specifies a directory that will store your .HTML files and provides the base location from which 
CorelWEB.DESIGNER resolves relative URLs to image files and other hyperlinked documents. 

Server Root
Specifies the directory location that stores all of the .HTML files and referenced objects used in your 
WEB.DESIGNER documents. Type a precise directory path or click the Browse button to search your local system 
for the appropriate directory.
Note
· After changing your server root directory, restart WEB.DESIGNER to apply the setting.



Applet Properties dialog box
Allows you to customize the appearance of applets in your WEB.DESIGNER page. The Applet Properties dialog 
box controls the selection and display of the Java Powered (TM) applets you import to your Web document, 
allowing you to specify properties that include applet class, alternate text for browsers that don’t support 
applets, spacing, alignment, and scaling values.
Applet

Applet Class Specifies the applet .CLASS file that you want to insert in your Web page. Pressing 
the Browse button allows you to search your local system for the file.

Codebase Identifies the directory path that leads to the applet .CLASS file if the file is saved 
in a directory other than your server root. The codebase entry must not contain 
the class file name.

Alternate Text Specifies the text that will appear in the applet's place if the applet cannot be 
displayed (due to browser incompatibility or availability problems).

Horizontal/Vertical Spacing Specifies pixel values for the horizontal and vertical spacing of your applet. 
Selecting the browser default option allows automatic regulation.

Alignment Specifies an alignment option for your applet. Choose from the browser default, 
baseline, top, middle, bottom, textop, absolute middle, absolute bottom, left, or 
right alignment options.

Scaling Regulates the width and height of your applet in pixel values. Scaling is most 
effective at the default (200 x 200) setting.

Parameters
Parameter Lists the parameters that correspond to the .CLASS file specified on the Applet tab.
Name Displays the parameter name.
Value Displays the parameter value.
Notes
· To edit or remove a parameter, double-click an entry in the main field of the Parameters tab.
· Only programmers who are experienced with the Java Programming Language should attempt to edit their 

applet's parameters.
· Once you have specified the Applet Class on the Applet tag, WEB.DESIGNER automatically inserts the 

appropriate parameters in the Parameters tag.



Bookmark dialog box
Lists the names of all the bookmarks in the current WEB.DESIGNER document. Once a bookmark has been set, 
you can create a hyperlink on the same page that jumps to the target location.

Bookmark Name
Names a formatted bookmark.

Other Bookmarks
Lists the names of all previously defined bookmarks in the current WEB.DESIGNER page.



Open dialog box
Opens files that have been saved on your local system. WEB.DESIGNER opens the dialog box to the directory 
that you have set as your server root.

File Name
Identifies the name of the file that you want to open. The dialog box lists files with the extension you specify in 
the Files of Type field.

Files of Type
Determines the file format that is displayed in the main area of the dialog box. WEB.DESIGNER automatically 
filters your system's files, displaying only .HTM and .HTML file types.

Look in
Lists the drives and directories on your local system, allowing you to search for the file that you want to open.



Save As dialog box
Saves a copy of your current file.

File Name
Identifies the file by name.

Save as type
Specifies the type of file listed in the Save As dialog box and saves your current document with the 
corresponding file extension. By default, CorelWEB.DESIGNER documents are saved with a .HTML file extension. 
You can expand the drop-down menu and choose All Files (*.*) to view all of the file types contained in a 
particular directory.

Save in
Specifies the drive in which to store the new file.
Note
· We recommend that you save your Web page inside your server root directory. If you save your Web page in a 

directory other than the server root, WEB.DESIGNER will copy all image files referenced with relative addresses
to the new location. When necessary, new folders will be created in the external directory to store the 
referenced files and mirror the original directory structure.



Print Setup dialog box
Identifies a printer and its connection.

Printer
Name Lists the printers that you can access from your system.
Status Identifies the current operating status of the selected printer.
Type Identifies the printer by name and type.
Where Identifies the port that connects the printer to your computer.
Properties Opens the printer properties dialog box, allowing you to set advanced printing 

options for your current document.

Orientation
Portrait Prints the current document using a portrait layout.
Landscape Prints the current document using a landscape layout.

Paper 
Size Determines the paper size that the printer will use to print your documents.
Source Specifies the paper source. Some printers offer multiple trays for different paper 

sources.



Print dialog box
Formats the appearance of your printed pages, offering print range, print to file, and collation properties.

Printer
Name Lists the printers that you can access from your system.
Status Identifies the current operating status of the selected printer.
Type Identifies the printer by name and type.
Where Identifies the port that connects the printer to your local system.
Properties Opens the printer properties dialog box, allowing you to set advanced printing 

options for your current document.

Print Range
All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To fields.

Print to File
Prints your document or documents to a PostScript file.

Copies
Specifies the number of copies to print for a specific page range.

Collate
Prints multiple copies in page number order.



Find dialog box
Locates a search string in the current WEB.DESIGNER document.

Find what
Displays the text or object that you want to locate.

Match case 
Restricts the search, locating only those instances of the specified search string that match the Find What entry 
exactly (including case).

Find Next
Searches the current WEB.DESIGNER document for the term specified in the Find What field.

Cancel
Closes the Find dialog box.



Replace dialog box
Specifies the search string and its replacement. After locating the search string, choose Replace to insert the 
replacement text, Replace All to replace all instances of the search string in your document, or Find Next to 
locate the next instance of the search string. 

Find what
Displays the text or object that you want to locate.

Replace with
Displays the search string's replacement text.

Match case 
Locates only those instances of the specified search string that match the Find What entry exactly (including 
case).

Find Next
Searches the WEB.DESIGNER document for the term specified in the Find What field.

Replace
Replaces the current instance of the search string with the term specified in the Replace With field.

Replace All
Replaces all instances of the search string with the term specified in the Replace With field.

Cancel
Closes the Replace dialog box.



Embedded File Properties dialog box
Displays the properties of any file that you embed in your WEB.DESIGNER document. Embedded files can include
.MPG files, Sun Audio (.AU) and MIDI files or any other file type that you can view in your Web browser or with 
accompanying plug in applications. Double-click an embedded file or select the file and choose Edit, Properties 
to display the Embedded File Properties dialog box.

Embedded file
Specifies the name and location of the file that you want to embed in your current WEB.DESIGNER document.

Horizontal Spacing
Browser Default Applies the default horizontal spacing to the embedded file.
Pixels Allows you to specify a horizontal spacing value in pixels.

Vertical Spacing
Browser Default Applies the default vertical spacing to the embedded file.
Pixels Allows you to specify a vertical spacing value in pixels.

Alignment
Controls the placement of the embedded file on your WEB.DESIGNER page.

Scaling
Width Specifies the width of the embedded file. The WEB.DESIGNER default value is 200.
Height Specifies the height of the embedded file. The WEB.DESIGNER default value is 

200.
Note
· A feature's properties can be altered limitlessly, so don't be afraid to substitute values and preview results. In 

fact, this type of experimentation often provides the best understanding of an element or property value.



Select HTML Browser dialog box
Specifies the directory path of the Web browser that you want to use to preview your WEB.DESIGNER 
documents. Type the path for the HTML Browser or click Browse to locate the file. The first time you choose the 
Set Browser command from the WEB.DESIGNER Tools menu, the Select HTML Browser dialog box appears. After 

specifying a browser, choose Tools, Browser Preview or click  to launch the specified browser directly from 
the WEB.DESIGNER window.

Path for HTML Browser
Displays the directory path leading to the executable file (.EXE) of the Web browser that you've selected for 
previewing your WEB.DESIGNER documents.



Color dialog box
Customizes the coloring of text and background elements in your Web page. You can access the Color dialog box 

by clicking , Custom Color or by clicking File, Page Properties, and opening the drop-down menus. Select a 
predefined color from the Basic Colors section of the dialog box or customize colors by specifying a point on the 
color palette. When you have defined an appropriate color, click Add to Custom Colors to add the shade to your 
custom color specifications.

Basic colors
Lists the most common color options. Choose a color and click OK to apply it to your work.

Custom colors
Stores 16 custom color specifications for future applications.

Add to custom colors
Copies the specified color to the Custom colors list.

Color/Solid
Previews a color that you specify on the custom color chart.
Notes
· If you choose a color from the Basic Colors chart, the color palette indicator moves to the corresponding shade

on the palette and a preview of your choice appears in the Color/Solid window.
· You can adjust the Hue, Saturation, and Luminosity qualities of a color by typing pixel values in the appropriate

fields.



Form Action Handler
Specifies the URL for the CGI script that will process input submitted by your form. Type the file location relative 
to your server root directory or click the Browse button to navigate directly to the CGI Script file location.

URL of CGI Script
Displays the URL of the CGI script that controls your form's functionality. The CGI script that you specify in the 
URL of CGI-Script field is responsible for serving up documents or creating new documents on request. You may 
leave the URL of CGI-Script field blank and identify the script at a later time by clicking the top or bottom of your 
form's border.
Note
· When a visitor to your Web page submits a form, the information is sent to your server. How the information is 

handled by the server is determined by CGI scripts. Consult your Webmaster about the setup and use of CGI 
scripts.



Select a sound file dialog box
Specifies a sound file that will play when a sound-capable browser accesses your WEB.DESIGNER document on 
the World Wide Web. The Select A Sound File dialog box allows you to choose a sound file and preview the sound 
before inserting it as background music for your page.

Look in
Lists the drives and directories on your local system, allowing you to search for the file that you want to open.

File name
Identifies the name of the file that you want to open. The Select A Sound File dialog box lists files with the 
extension you specify in the List Files Of Type field.

Files of type
Regulates the file type that is displayed in the main area of the Select A Sound File dialog box. WEB.DESIGNER 
automatically filters your system's files, displaying Wave files, Aiff files, Au files, Midi files, or all files contained in
the specified directory.

Play a sound file
Plays a selected sound file before inserting it as the background sound for your Web page.

Stop sound
Stops playing the sound file.
Note
· The CorelWEB.DESIGNER background sound feature is only supported by browsers that recognize the 

<BGSOUND> HTML tag, e.g., Microsoft's Internet Explorer.



Undo

Reverses the most recent action performed in the WEB.DESIGNER window. You can also reverse your most recent
action by pressing CTRL+Z.



Redo

Reverses the action performed by the Undo command. You can also redo actions by pressing CTRL+SHIFT+Z.



Cut

Removes the selected data from your document and copies it to the Windows Clipboard. The copied text 
replaces any previous Clipboard contents. You can also cut and copy data by pressing CTRL+X.



Copy

Copies selected data to the Windows Clipboard, replacing any previous Clipboard contents. You can also copy 
data to the Clipboard by pressing CTRL+C.



Paste

Adds a copy of the Windows Clipboard contents to your Web document at the current cursor location. You can 
also paste the Clipboard contents in your Web page by pressing CTRL+V.



Clear

Deletes the selected text or object without copying it to the Windows Clipboard. You can also delete selected text
by pressing DEL [key].



Select All

Selects the contents of your current Web page. You can also select the contents of your current Web page by 
pressing CTRL+A.



Find

Opens the Find dialog box, allowing you to search for text and other Web page elements including, fonts, styles, 
and special characters. You can also activate a search by pressing CTRL+F.



Find Next

Activates the search specified in the Find dialog box. You can also activate a search by pressing F3.



Replace

Opens the Replace dialog box, allowing you to replace a search string with alternate text or objects. You can also 
open the Replace dialog box by pressing CTRL+H.



Edit HTML Source

Displays the HTML Source code that corresponds to WEB.DESIGNER's WYSIWYG presentation of your current Web
page.



Properties

Displays the property settings for the selected element. To edit an object's properties, select the element, click 
Edit, Properties, and adjust the settings in the Properties dialog box.



New

Opens a fresh WEB.DESIGNER screen, allowing you to create a new Web document. You can also open a new 
WEB.DESIGNER window by pressing CTRL+N.



Open

Opens an existing HTML document. You can open multiple documents at once by choosing View, New Window. 
You can also open an existing HTML document by pressing CTRL+O.



Templates

Creates a new Web document from a pre-designed template. Click File, Templates and choose a template from 
the Choose Web Page Template dialog box. Double-click the template file name or select the file and click Open. 
The template's structure provides a sample on which to base your new Web page. You can also open a 
WEB.DESIGNER template by pressing CTRL+T.



Save

Saves the current Web page. When you save a Web page for the first time, CorelWEB.DESIGNER displays the 
Save As dialog box, allowing you to name your file. We recommend that you save your Web pages inside your 
server root directory. You can also save a document by pressing CTRL+S.



Save As

Opens the Save As dialog box, allowing you to name and save your current file. To save a document with its 
existing name and directory, click File, Save. We recommend that you save your Web page inside your server 
root directory.



Print Setup

Opens the Print Setup dialog box, allowing you to select a printer and a printer connection and to modify your 
print properties.



Print

Opens the Print dialog box, allowing you to regulate the range of printed pages, the number of copies, the 
destination printer, and the appearance of your printed document. You can also open the print dialog box by 
pressing CTRL+P.



Page Properties

Opens the Page Properties dialog box allowing you to adjust the title, background, and text color of a current 
WEB.DESIGNER document.



Recent File

Displays an ordered list of the most recently accessed WEB.DESIGNER documents. To open a file listed in the 
Recent File menu listing, click the appropriate filename.



Exit

Closes the current WEB.DESIGNER window and exits the application. WEB.DESIGNER prompts you to save any 
changes you've made to your file prior to closing the program. You can also close WEB.DESIGNER by pressing 
ALT+F4 or by clicking the Close icon in the application's title bar.



Normal

Formats the current paragraph in Normal font, removing all existing HTML tags from the text.



Heading

Applies a heading style to selected text, corresponding to the HTML <H1> through <H6> tags. To format a 
paragraph of text with a Heading Style, position your cursor in the paragraph, click Format, and choose a 
heading style.



Preformatted Text

Displays selected text in a monospace font, retaining all line breaks and spaces, corresponding to the HTML 
<PRE> tag. To format a paragraph of text with the HTML <PRE> tag, position your cursor at any point in the 
paragraph and click Format, Preformatted Text.



Block Quotation

Indents selected text and inserts paragraph breaks before and after the block quotation tag, corresponding to 
the HTML <BLOCKQUOTE> tag. To format a paragraph of text with the HTML <BLOCKQUOTE> tag, position your 
cursor at any point in the paragraph and click Format, Block Quotation.



Ordered List

Displays selected text in a numbered list, corresponding to the HTML <OL> and <LI> tags. To remove the 
ordered list formatting from list items, select the text and click Format, Ordered List.



Unordered List

Displays selected text in a bulleted list, corresponding to the HTML <UL> and <LI> tags. To remove the 
unordered list formatting from list items, select the text and click Format, Unordered List.



Hyperlink

Opens the Hyperlink Properties dialog box, allowing you to define a new hyperlink URL for the selected text or 
image on your Web page.



Bookmark

Opens the Bookmark dialog box, allowing you to mark the selected text as a target for a hyperlink.



Designing forms
With the CorelWEB.DESIGNER form functions you can create online forms for a variety of purposes such as to 
allow visitors to comment on your page or to purchase a product online. WEB.DESIGNER's form functions allow 
you to create and customize virtually any form style so that you can create text fields, radio buttons, check 
boxes, and other advanced form elements within minutes.
To help you build forms, CorelWEB.DESIGNER provides the Forms toolbar.
Note
· When visitors to your Web site submit a form, the data is sent to your server. From there, CGI scripts 

determine how the data is handled. For more information on creating and using CGI scripts, consult your 
Webmaster.

See Also
Creating a new form
Adding elements to a form
CGI scripting
Insert menu
Forms toolbar



Creating a new form
With CorelWEB.DESIGNER's form features you can design feedback forms, questionnaires, surveys, or purchase 
orders to publish on the Web. However, to achieve full form functionality, you must specify the URL of a CGI 
script that will process your form's data and serve up the appropriate responses.

To create a new form
1. Position your cursor at the point in your Web page where you want to insert a form.

2. Click Insert, Form or click .
CorelWEB.DESIGNER displays the Form Action Handler.

3. Type the URL of a CGI script or click Browse to specify the CGI Script that will process the form's input.
CorelWEB.DESIGNER displays a rectangular region defined by a red dashed line in which you can add form 

elements and structure the layout of your page.
Note
· Even if you do not know the location of the CGI script or do not have a CGI script, you can still design forms 

using CorelWEB.DESIGNER. Simply click OK in the Form Action Handler and consult your Webmaster prior to 
placing your pages on a server. The form will not function until you specify an appropriate CGI Script.

See Also
Designing forms
Adding elements to a form
CGI scripting
Forms toolbar buttons
Insert menu



Adding elements to a form
With CorelWEB.DESIGNER's Form menu commands and toolbar options, you can easily add new elements to your
online forms.

To add form elements
1. Position your cursor inside the form border.

2. Click a form element button on the Forms toolbar. For example, click  to add a text field to your form.
3. Type introductory text beside each form element, prompting your visitors to fill in the appropriate 
information.
4. Double-click the form element.

WEB.DESIGNER opens the corresponding Properties dialog box.
5. Set the element's attributes and click OK.

Notes
· To configure the labels on the Submit and Reset buttons of your form, double-click the button, then specify a 

label and configure the button (type) to Submit or Reset your form's contents.
· If you double-click the form border, CorelWEB.DESIGNER displays the Form Properties dialog box, allowing you 

to specify a CGI script in the Form Action Handler.

See Also
Designing forms
Creating a new form
CGI scripting
Insert menu
Forms toolbar



CGI Scripting
The Common Gateway Interface (CGI) is responsible for most of the more complex movement and interaction 
that occurs in World Wide Web forms, acting as a means of communication with programs on other computers. 
CGI scripts allow Web browsers to run programs directly without the help of external applications. With CGI 
scripts, you can scan databases, sort names, send mail or perform almost any other interactive function.
With standard HTML pages, you access a link to a URL, instructing your browser to read, interpret, and display 
information contained on another Web site. With hyperlinks, clients direct their browsers to a specific screen of 
information. But with CGI scripts, an information provider serves up different documents depending on a client's 
request. More importantly, the CGI allows the program or script to create new documents at the time clients 
make their requests.
Forms are one of the most popular uses for CGI on the Web, allowing advanced interaction and information 
exchanges in an active environment. Like most other Web editors, CorelWEB.DESIGNER supports HTML form tags
but does not generate CGI scripts. This means that you can use WEB.DESIGNER to construct forms for your Web 
pages but until you specify a CGI script in the Form Action Handler, your forms will remain static. Before you can 
publish pages that return requested data, respond to user input, or log accesses, you must specify the CGI 
program that will control your form's operations. For more information on CGI scripting, contact your Webmaster.

See Also
Designing forms
Creating a new form
Adding elements to a form
Forms toolbar
Insert menu
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A
Addons
Address
Anchor
Applet
Attribute

B
Bitmap (.BMP)
Bookmark
Browser

C
CERN
CGI
Clickable Map
CorelWEB.DRAW
CorelWEB.GALLERY
CorelWEB.MOVE
CorelWEB.WORLD
CorelWEB.Transit

E
Email
Embedded File

F
Font



Form
FTP

G
Gopher

H
HotJava Browser(TM)
Hotspot
HTTP
HTML
HTML 2.0
HTML 3.0
Hyperlink
Hypermedia
Hypertext

I
Image map
Internet
Internet Explorer

J
Java (TM)
JPEG Bitmap (.JPG)
L

Link
N

NCSA
Netscape Extensions
Netscape Navigator
Net
Newsgroups

P
Page
Pixel
Plug-ins
Properties
R

Redo
Refresh
S

Script
Site
SGML
Surfing

T
Table
Telnet



Template
TIF
Toolbar

U
Undo
URL

V
VRML

W
WAIS
Web
World Wide Web
See Also
CorelWEB.DESIGNER basics
CorelWEB.DESIGNER screen tour
CorelWEB.DESIGNER tools
Tips and tricks
Using CorelWEB.DESIGNER



Addons
An external program or helper application that can be added to a Web browser. Addons perform functions and 
display file types that the Web browser cannot handle internally.



Address
The string of characters that identifies you, an Internet file, or an Internet site. Email addresses usually take the 
form username@host.name.type, and gopher addresses look like cwis.usc.edu. World Wide Web addresses are 
called Universal Resource Locators or URLs. 



Anchor
The source or destination of a hypertext link in a Web document. External links extend from one anchor to another 
document or from another document to that anchor. A link's source anchor or starting point usually appears 
highlighted in your Web browser. Clicking your mouse on a source anchor transports you to the corresponding 
destination anchor.



Applet
An applet is a small program, based on the Java (TM) Programming Language, that can be included in an HTML 
page. When you use a Java-compatible browser to view a page that contains an applet, the applet's code is 
transferred to your system and executed by the browser.



Attribute
A property of an HTML element that appears in the opening tag of the element. In the HTML sequence <TABLE 
COLSPAN=6>, COLSPAN is an attribute, defined by the <TABLE> tag.



Browser
A viewing mechanism used for observing hypertext on the World Wide Web, technically referred to as a Web client. 
A browser allows you to view pages and navigate Web archives.



Bitmap (.BMP)
The file name extension for bitmap images. Bitmaps are images composed of a series of pixels or dots. Scanners 
and paint programs such as CorelPHOTO-PAINT generate this type of image.



Bookmark
A bookmark codes and identifies a specific location within a WEB.DESIGNER document. Once you have set a 
bookmark, you can create a hyperlink to the bookmark's location. You can create a bookmark for any text string or 
image by selecting the item and formatting your selection using the Bookmark command in the WEB.DESIGNER 
Format menu. This procedure makes the new bookmark available to all hyperlinks created within the document.



CERN
(Centre Europeen pour la Recherche Nuleaire) A European physics laboratory and birthplace of the World Wide Web.
For more information on CERN, consult the CERN home page at http://www.cern.ch/.



CGI
(Common Gateway Interface) Addon programs that run in the browser, eliminating the need for external 
applications. When a user selects a URL that leads to a CGI script, programs launch on the server system to scan 
databases, sort names, send mail, or perform any other function you want.



Clickable Map
An inline image with multiple, defined regions, each linking to a different location on the World Wide Web.



CorelWEB.Transit
An application in the CorelWEB.GRAPHICS SUITE package that converts standard word processing files to .HTML 
format. Once the file is converted you can edit the HTML document in CorelWEB.DESIGNER.



CorelWEB.MOVE
An application in the CorelWEB.GRAPHICS SUITE package that allows you to create or edit animations. Completed 
animations can be inserted in your WEB.DESIGNER documents for publishing on the Web.



CorelWEB.DRAW
An application in the CorelWEB.GRAPHICS SUITE package that allows you to create or edit your own graphic files. 
Completed image files may be inserted in your WEB.DESIGNER documents for publishing on the Web.



CorelWEB.GALLERY
An application in the CorelWEB.GRAPHICS SUITE package that supplies you with thousands of ready-to-use graphic 
images for integration in your WEB.DESIGNER pages. Simply drag and drop the WEB.GALLERY images onto your 
CorelWEB.DESIGNER screen to give color and life to your documents.



CorelWEB.WORLD
An application in the CorelWEB.GRAPHICS SUITE package that allows you to create VRML files. Completed VRML 
files may be inserted in your WEB.DESIGNER documents for publishing on the Web.



Email
An abbreviation for Electronic Mail, referring to a messaging system that also incorporates file transfer. Email 
transmits messages from one person to another via computer and can also send messages to a large number of 
addresses (Mailing List).



Embedded File
A file of any type, including .MPG files, Sun Audio (.AU) and MIDI files, that you can view in your Web browser or 
with accompanying plug-in applications. WEB.DESIGNER's Embedded File command quickly merges files of any type
with your Web pages, allowing you to create more advanced and efficient Web documents.



Font
A set of characters in a particular size and style (typeface). A font includes letters, numbers, punctuation marks, 
and other characters.



Form
An advanced means of interaction on the World Wide Web, largely dependent on CGI scripting. With the 
CorelWEB.DESIGNER form functions you can create forms for a variety of purposes such as to allow visitors to 
comment on your page or to purchase a product online. Form functions allow you to create and customize virtually 
any form style so that, within minutes, you can create text fields, radio buttons, check boxes, and other form 
elements.



FTP
(File Transfer Protocol) A common method of transferring files between remote computers. The most popular 
Internet use is anonymous FTP where you log in to a remote system using the login name anonymous and typing 
your full Internet address as the password. With anonymous FTP, you don't need an account on the remote 
computer to access files. Essentially, FTP is a special way to login to a remote Internet site to retrieve and/or send 
files.



Gopher
A Client/Server program that makes menus of text-based material available over the Internet. Although Gopher 
spread rapidly across the globe in only a couple of years, it is being largely supplanted by hyperdocuments on the 
World Wide Web. You can perform many functions from Gopher, including FTP, telnet, and searches.



HotJava Browser (TM)
A prototype of a WWW browser that displays applications contained in .HTML files and is written in the Java 
Programming Language (TM). The data viewed in standard Web browsers is limited to text, illustrations, and low-
quality sounds or videos, but with the HotJava Browser, you can add interactive science experiments, games, 
specialized shopping applications, interactive advertising, and even customized newspapers.



Hotspot
A defined hypertext region. A hotspot is the source anchor of a hyperlink and is typically highlighted or otherwise 
distinguishable from standard text.



HTTP
(HyperText Transport Protocol) The protocol for moving hypertext files across the Internet. Requires a HTTP client 
program on one end, and an HTTP server program on the other end. The HyperText Transfer Protocol abbreviation 
(http) appears at the beginning of all World Wide Web addresses (e.g., http://www.corel.com).



HTML
(HyperText Markup Language) The coding language used to create Hypertext documents on the World Wide Web. 
HTML is a tag-based language that allows you to surround text blocks with codes that control their appearance. 
More importantly, HTML allows you to create hypertext documents by linking a word or phrase to another Internet 
file. HTML files are meant to be viewed using a World Wide Web Client Program, such as Netscape Navigator or 
Microsoft's Internet Explorer.



HTML 2.0
An HTML standard that defines the conformance of HTML documents (Web pages) and certain aspects of HTML user
agents (Web browsers).



HTML 3.0
HTML 3.0 is a set of extensions to the standard HTML coding specifications. HTML 3.0 extensions include support for
fill-out forms, tables, mathematical equations, and floating figures.



Hyperlink
A relationship between two anchors. Internal hyperlinks connect information stored on the same database and 
external hyperlinks connect information stored on different databases.



Hypermedia
A concept that combines the principles of hypertext with graphic, sound, and video applications.



Hypertext
Any text that links directly to other documents. Hypertext is text that is not constrained to a single sequence for 
observation.



Image map
An image-map is a file that projects multiple hyperlinks on different regions of an image file, allowing users to click 
a specified region and jump to the hyperlinked Web page defined for that area. CorelWEB.DESIGNER handles client-
side and server-side image mapping.



Internet
The vast collection of inter-connected networks that use TCP/IP protocols and that evolved from the ARPANET of the 
late 60s and early 70s. The Internet connects thousands of remote computers to an extensive global network.



Internet Explorer
An advanced browsing application created by the Microsoft Corporation. Internet Explorer can be used to view HTML
pages on the World Wide Web.



Java (TM)
A programming language invented by Sun Microsystems, specifically designed for writing programs that can be 
safely downloaded from the Internet and immediately run without fear of viruses or other harm to your system. 
Small Java Powered programs are called applets.



JPEG Bitmap (.JPG)
The file name extension for Joint Photographic Experts Group — a graphic format supported by CorelWEB.DESIGNER
and most Web browsers.



Link
A relationship between two anchors. Internal hyperlinks connect information stored on the same database and 
external hyperlinks connect information stored on different databases.



NCSA
The National Center for Supercomputing Applications at the University of Illinois at Champaign-Urbana, the home of 
the Mosaic Web browser.



Netscape Extensions
Unique HTML tags, developed by Netscape Communications and recognized by the Netscape Navigator Web 
browser.



Netscape Navigator
An advanced Web browsing application created by Netscape Communications Corporation. Netscape Navigator can 
be used to view HTML pages on the World Wide Web.



Net
An abbreviated term referring to the Internet.



Newsgroups
An automated message area, usually operated through USENET in which subscribers post messages to an entire 
group on a wide variety of topics. USENET is a world-wide system of discussion groups.



Page
A single file of Hypertext Mark-Up Language that can be viewed with a Web browser. Typically these pages combine 
text, images, and multimedia features, including hypertext links that jump to other Web pages. One of the most 
common Web pages is the home page which acts as an entry point to a local Web.



Pixel
The smallest resolvable element of a computer image. A pixel is rectangular and is either on a screen or stored in 
memory.



Plug-ins
Software addon programs that extend the capabilities of a browser in a specific way. Plug-in applications allow you 
to access file types that are unsupported by your browser. For example, some plug-in applications allow you to play 
audio samples or view movie clips directly from your Web browser.



Properties
The characteristics or attributes of an HTML element. With WEB.DESIGNER, you can adjust an element's attributes 
by double-clicking the element or by selecting it and choosing Edit, Properties. Many Web elements have their own 
properties dialog boxes that can be used to change the feature's appearance or characteristics. For example, one 
way to edit a table that you have already inserted in your Web document is to choose Table, Table Properties.



Redo
The Redo command allows you to repeat commands that were previously undone by the Undo command.



Refresh
The Refresh command redraws the screen.



Script
A script (macro) is a computer program that executes a series of instructions with a single command. Generally, 
scripts are used to automate repetitive tasks or simplify complicated actions, but they can also prompt for user 
input, display messages, and interact with other applications.



Site
A file section of a computer where particular documents reside; for example, a Web site, a Gopher site, or an FTP 
site. Web sites are addressed locations on the Internet that provide access to a set of HTML documents that 
correspond to a particular URL. A Web site consists of a Web server and a named collection of Web documents, both
accessible through a single URL.



SGML
(Standard Generalized Markup Language) An open document definition language used frequently in the publishing 
industry. HTML is a definition under SGML. An SGML document consists of data characters and markup codes. The 
markup describes the structure of the information and an instance of that structure.



Surfing
Navigating or moving (virtually) from computer to computer on the Internet, usually not staying too long in one 
place.



Table
An HTML 3.0 specification that allows you to create customized organizational charts, calendars, schedules, and 
more. Customized layout, alignment, and sizing options allow you to produce unique, structured pages that appeal 
to your audience. Your table's cells can hold most HTML elements, and while textual inserts remain the most 
popular, online tables can also integrate images, image maps, and other tables.



Telnet
The command and program used to login from one Internet site to another. The telnet command/program 
transports you to the login: prompt of another host.



Template
A collection of sample files stored in .HTML format. You can open a template and edit its contents to easily create 
customized documents.



.TIF Bitmap
The file name extension for Tagged Image File Format — a bitmap graphic format.



Toolbar
A set of icons or buttons that provide quick, one-step access to commonly used menu commands and features.



Undo
The Undo command removes the effect of the most recent WEB.DESIGNER action.



URL
(Uniform Resource Locator) A World Wide Web address or identifier used to locate specific information sites on the 
Web. The most common way to use a URL is to type the address into a WWW browser program, such as Netscape, 
or Internet Explorer. URLs are preceded by the HTTP protocol (http://).



VRML
(Virtual Reality Modeling Language) A specification for three-dimensional rendering used with Web browsers.



WAIS
(Wide Area Information Servers) A commercial software package that allows the indexing of huge quantities of 
information and makes those indices searchable across networks. WAIS search results are ranked (scored) 
according to the relevance of the hits.



Web
An abbreviated term referring to the World Wide Web (see World Wide Web).



World Wide Web
(WWW) The World-Wide Web is a hypertext-based, distributed information system created by researchers at CERN 
in Switzerland. http://www.w3.org/. Web clients (browsers) can access multi-protocol and hypermedia information 
using an addressing scheme.



Contents

Displays the opening Help screen. From the Contents page, you can jump to instructions for using 
CorelWEB.DESIGNER and various types of reference information. Click the Contents button at the top of the Help 
window to open the Contents page from any point in the WEB.DESIGNER help system.



Screen/Menu Help

Converts your mouse to a question mark pointer and activates WEB.DESIGNER's context-sensitive Help. Clicking 
the Screen/Menu Help button or clicking Help, Screen/Menu Help and choosing a menu command or tool displays
the corresponding Help topic. To access the main help file, click Help, Contents, or press F1. You can also activate
the Screen/Menu Help by pressing SHIFT+F1.



Search For Help On

Opens the CorelWEB.DESIGNER Help index, allowing you to conduct a search for specific information. From the 
Search For Help On index, you can jump to instructions for using CorelWEB.DESIGNER and various other 
reference information. You can also access the online Help index by clicking the Index button at the top of the 
WEB.DESIGNER Help window.



Technical Support

Lists technical support and customer service information contacts.



Tutorial

Opens the CorelWEB.DESIGNER tutorial — a hands-on approach to learning CorelWEB.DESIGNER.



WEB.GRAPHICS SUITE Web Page

Opens the WEB.GRAPHICS SUITE Web Page directly from the WEB.DESIGNER window. Free product updates, 
tutorials, and other related software are available at this site 
(http://www.corel.com/corelweb/webgraphics/downloads/).



About CorelWEB.DESIGNER

Opens a dialog box that displays the application version, your registration status, and informative World Wide 
Web contacts.



Inserting images
One way to make a site more attractive and functional is to include graphic images. CorelWEB.DESIGNER 
handles two graphic file formats directly: .JPG and .GIF. Three other file formats (.TGA, .BMP, and .PCX) will be 
automatically converted to .GIF or .JPG file format when you add them to your Web pages.

To insert images in a Web page
1. Position your cursor at the point on your Web page where you want to insert an image.

2. Click Insert, Image or click .
CorelWEB.DESIGNER opens the Image Properties dialog box.

3. Click the Browse button beside the Image Source field.
WEB.DESIGNER opens your server root directory in the Select Image Source dialog box.

4. Select an image file and click Open.
5. Click OK.

CorelWEB.DESIGNER updates your Web page and displays the new image file.
Notes
· You can also insert animated GIFs using the Inserting images procedure.
· To make changes to any of the image properties, double-click the image and set values in the Image Properties

dialog box.
· Double-clicking an image also gives you access to WEB.DESIGNER's image map feature.

See Also
Adding image map hyperlinks
Creating image maps



Creating image maps
Using CorelWEB.DESIGNER, you can create an image-map file that projects multiple hyperlinks on different 
regions of an image. When you click on a mapped region of an image in a browser window, you jump to the 
hyperlinked Web page that has been specified for that area. CorelWEB.DESIGNER handles image maps in two 
ways:
· the image map is embedded in the Web document, to allow client-side image mapping.
· an image map file is created for the server, to allow server-side image mapping.

To create an Image map file
1. Double-click the Image.

CorelWEB.DESIGNER displays the Image Properties dialog box.
2. Choose the Image Map tab.
3. Enable the Use Image Map check box. 
4. Click Create Map.

CorelWEB.DESIGNER displays the Image Map Editor window, allowing you to specify regions of your image, 
define hyperlinks, and type a corresponding Target URL for each hyperlinked area.

Notes

· You can also select an image and click  to go directly to the Image Map Editor and edit or create a new 
image map file.

· To edit an existing image map file, choose Edit Map on the Image Map tab.
· Server-side image maps are NCSA compliant.
· Image maps are not explicitly referenced in the document tree structure. Instead, you will see an <A 
HREF> reference to the map file you created, along with the image source beneath the opening <BODY> tag. If you
insert an .HTML file containing an image map in your current Web document, WEB.DESIGNER references the image 
map file outside of the </HTML> tag at the bottom of the Document Tree structure.

See Also
Adding image map hyperlinks
Inserting images



Adding image map hyperlinks
Once you have loaded an image in the Image map editor, you must define hyperlinked regions on the image and
specify destination URLs for the links. For more information about hyperlinks and URLs, see the Creating 
hyperlinks section of the CorelWEB.DESIGNER online Help system.

To define a new hyperlink area for your image-map file
1. Click the map tool that corresponds to the shape of the hyperlinked region that you want to define.
2. Define a hyperlinked region.
3. Type the destination URL in the Target URL field or click Browse and navigate to the target file.
4. Repeat steps 1 to 3 and specify hyperlink target URLs for all the regions of your image file.
5. Click Save.

CorelWEB.DESIGNER opens the Save Image Map File dialog box.
6. Type a name in the File name field and specify a directory location in which to save the map file.

WEB.DESIGNER saves the hyperlink target URL information in a .MAP file for server-side image maps Client-
side image maps are created at the same time.

Draw a circle
Draw a rectangle
Draw a polygon
Notes
· To remove a rectangle, circle, or polygon from your image map file, select the element and press DEL [key].
· To see your latest changes, you may need to click View, Refresh Window.
· Image maps are not explicitly referenced in the document tree structure. Instead, you will see an <A HREF> 

reference to the map file you created, along with the image source beneath the opening <BODY> tag. If you 
insert an .HTML file containing an image map into your current Web document, WEB.DESIGNER references the 
image map file outside of the </HTML> tag at the bottom of the Document Tree.

See Also
Creating image map files
Creating hyperlinks
Inserting images



To draw a circle

1. Click the circle tool.
2. Click and drag to draw the circle.



To draw a rectangle

1. Click the rectangle tool.
2. Click and drag to draw the rectangle.



To draw a polygon

1. Click the polygon tool.
2. Click and drag to draw the polygon.
3. Double-click to close the polygon.



Image map editor

Opens the image map editor, allowing you to edit or create an image map file for the currently selected image.



Form

Opens the Form Action Handler in the Form Properties dialog box, allowing you to specify the URL of the CGI 
script that will process your form's data. Click OK to insert a new HTML form at your current cursor position.



Form, Text Field

Adds a text field element to the active form. All form commands are available from the Insert menu and the 
Forms toolbar.



Form, Button

Adds a button element to the active form. All form commands are available from the Insert menu and the Forms 
toolbar.



Form, Check Box

Adds a check box element to the active form. All form commands are available from the Insert menu and the 
Forms toolbar.



Form, Radio Button

Adds a radio button element to the active form. All form commands are available from the Insert menu and the 
Forms toolbar.



Form, List/Menu

Adds a list or menu element to the active form. All form commands are available from the Insert menu and the 
Forms toolbar.



Image

Opens the Image Properties dialog box, allowing you to specify an image to add to your current document.



Horizontal Rule

Opens the Horizontal Rule dialog box, allowing you to edit the properties of a horizontal rule on your Web page.



Paragraph

Inserts a blank space and moves your cursor to a new line on the WEB.DESIGNER screen (hard return). You can 
also create a paragraph break by pressing ENTER [key].



Line Break

Moves your cursor to a new line on the WEB.DESIGNER screen (soft return). You can also create a line break by 
pressing SHIFT+ENTER [key].



HTML File

Inserts and merges an existing .HTML file with your current CorelWEB.DESIGNER document. Using the HTML File 
command, you can merge all .HTML files including those containing Java Powered (TM) applets.



Applet

Opens the Applet Properties dialog box, allowing you to insert a Java Powered (TM) applet in your 
CorelWEB.DESIGNER document. This command quickly merges pre-designed applets.



Embedded File

Opens the Embedded File Properties dialog box, allowing you to insert any file in your CorelWEB.DESIGNER 
document. The Embedded File command quickly merges files of any type with your Web pages, allowing you to 
create more advanced and efficient Web documents.



Ordered List

Formats the first entry for an ordered or numbered list at your current cursor position, corresponding to the HTML
<OL> and <LI> tags.



Unordered List

Formats the first entry for an unordered or bulleted list at your current cursor position, corresponding to the 
HTML <UL> and <LI> tags.



 CorelWEB.DESIGNER Help Contents

 

 

 

 

 

Notes
· In addition to the information accessed from the Help Contents page, you'll find useful definitions and tips for 

menu items or toolbars when you press the Screen/Menu Help button,  and choose a CorelWEB.DESIGNER 
command.

· You can access Help for individual dialog boxes by clicking the Help button within the dialog box.
· Free product updates, tutorials, and other related software will be available from the WEB.GRAPHICS SUITE 
Web Page. Click Help, WEB.GRAPHICS SUITE Web Page and choose OK to directly access this page 
(http://www.corel.com/corelweb/webgraphics/downloads/).



CorelWEB.DESIGNER Basics
Before launching into any Web design project, you must understand the basic principles of page construction 
using the CorelWEB.DESIGNER Web editing tools. The following links provide you with information on the WWW, 
HTML, and WEB.DESIGNER's document creation strategies:

CorelWEB.DESIGNER introduction
The World Wide Web and HTML
Organizing files
Editing Web page elements
See Also
CorelWEB.DESIGNER screen tour
CorelWEB.DESIGNER tools
Tips and tricks
Using CorelWEB.DESIGNER
Glossary of terms



CorelWEB.DESIGNER Introduction
In recent years the popularity of the Internet has grown tremendously, making the Net and its offspring, the 
World Wide Web, two of the fastest growing communication mediums in the world. Currently, millions of people 
world-wide are developing their own Web pages to advertise businesses, to sell products, to entertain, or to 
communicate on a global basis. Creating a World Wide Web page grants a single person the ability to reach 
millions of potential customers, clients, and friends around the world.
Until now, creating and maintaining a World Wide Web page required extensive knowledge of the Hypertext 
Markup Language (HTML), but with CorelWEB.DESIGNER, publishing pages on the Web becomes easy. 
CorelWEB.DESIGNER is a Web authoring tool that was designed for the average word processing user, but that is 
powerful enough for professional Web artists. With this program you can develop high-quality pages without 
having to deal with complex HTML tags and extensions. Simply put, CorelWEB.DESIGNER gives you the power 
you want, and the flexibility you need, to create quality Web pages with ease.
To simplify the Web construction process, CorelWEB.DESIGNER allows you to enter and edit text the same way 
you do in most word processing applications. WEB.DESIGNER includes word processing styles and features such 
as formatting toolbars, spell checking options, cut and paste functions, and find or replace commands. With 
CorelWEB.DESIGNER, even novice Web authors can edit existing Web pages or create new ones using templates,
images, hyperlinks, hotspots, forms, and character or paragraph styles.

See Also
The World Wide Web and HTML
Organizing files
Editing Web page elements



The World Wide Web and HTML
Due to recent expansion and high-speed advancement, the World Wide Web has become a staggering 
information resource. Millions of individuals and organizations across the globe have published pages on the Web
so that anyone, anywhere, can obtain any information they need. When you visit a World Wide Web site, you 
access information stored on another computer. The contents of all Web sites are coded in Hypertext Mark-Up 
Language (HTML) and the computer that stores the site is called a Web server. The viewing device that accesses 
information from the World Wide Web site and displays it on your computer screen is called a Web browser.
Some companies, including Netscape and Microsoft, have recently enhanced their Web browsers with new 
display capabilities such as applet support, animated GIF presentation, or VRML display. As a result, these 
companies have created some unique HTML tags, supported only by their particular browser. Because Web 
surfers use many different browsers to view World Wide Web sites, the unique HTML enhancements may be 
displayed by one browser, but not by another, depending on the types of tags that were used by the author of 
the page. To address the incompatibility problems that unique HTML tags create, and to ensure that the largest 
possible audience has access to WEB.DESIGNER sites, the CorelWEB.DESIGNER application uses HTML tags that 
most major browsers support.
Each time you type a Uniform Resource Locator (URL) or Internet address into your browser, you send a signal to 
the server that holds that address, requesting its information. The same process takes place when you click a 
hyperlink on a Web page. But while you type a location URL in the Address box at the top of your browser 
window, a link's destination or target site is embedded into the hyperlink by the Web page author. In both cases, 
URLs can reference text and images, an online newsgroup, an email address, or any other information located on
an Internet server.
Note
· Usually, Web pages are set up on dedicated servers. A dedicated server is a central computer that stores Web 

pages exclusively, and runs continually, ensuring that information can be accessed at all times. Service 
providers store Web pages on dedicated servers and provide users with access to the Internet for monthly or 
annual fees.

See Also
CorelWEB.DESIGNER introduction
Organizing files
Editing Web page elements



CorelWEB.DESIGNER tools

CorelWEB.DESIGNER works like most other standard Windows applications. You can perform operations by 
choosing menu options or by clicking the toolbar icons.
CorelWEB.DESIGNER Tools provides help on the following topics:
CorelWEB.DESIGNER menus
Using toolbars
HTML tag reference
Shortcuts

See Also
CorelWEB.DESIGNER basics
CorelWEB.DESIGNER screen tour
Tips and tricks
Using CorelWEB.DESIGNER
Glossary of terms



Using CorelWEB.DESIGNER

Once you have familiarized yourself with WEB.DESIGNER's main design principles, you're ready to begin using 
this advanced WWW editing tool. Help for creating and updating HTML Web pages is available for the following 
topics:
Starting a new Web project
Working with text
Managing images and image attributes
Formatting bookmarks and hyperlinks
Creating and modifying HTML tables
Designing forms
Editing and previewing your work
Integrating advanced elements
Publishing files to WEB.DESIGNER

See Also
CorelWEB.DESIGNER basics
CorelWEB.DESIGNER screen tour
CorelWEB.DESIGNER tools
Tips and tricks
Glossary of terms



Starting a new Web project

Creating new Web pages
Specifying basic Web page properties
Saving Web pages
Splitting or opening a new document window
Re-enabling the welcome on startup screen
Adding horizontal rules



Working with text

Adding and formatting text
Copying and pasting text from other applications
Adding bold, emphasis, and other character formats
Finding and replacing text
Creating ordered and unordered lists



Managing images and image attributes

Inserting images
Creating image maps
Adding image map hyperlinks



Formatting bookmarks and hyperlinks

Using bookmarks within a document
Removing bookmarks
Creating hyperlinks



Creating and modifying HTML tables

Designing tables
Creating a new table
Modifying table elements
Specifying boundaries in the Table Properties dialog box
Setting your table's background color



Designing forms

Designing forms
Creating a new form
Adding form elements



Editing and viewing your work

Spell checking Web pages
Viewing and editing HTML Source code
Editing your favorite published pages
Reversing the most recent action
Setting up a browser
Viewing your Web pages
Viewing VRML
Viewing Barista files



Integrating advanced elements

Adding sound
Merging .HTML files
Inserting Java powered (TM) applets
Embedding files



Publishing files to WEB.DESIGNER

Publishing files to WEB.DESIGNER
Inserting animations
Using animations
Inserting VRML
Converting word processing files
Adding WEB.GALLERY images
Creating and inserting your own graphics
Publishing in the Java Programming Language (TM) with Barista



CorelWEB.DESIGNER menus
The CorelWEB.DESIGNER menus allow you to create and manipulate your HTML documents (also referred to as 
Web pages). In many cases, the operations you perform using menu commands are also available via toolbar 
buttons or shortcut keys.

Menu Description
File Provides standard Windows menu commands for 

· creating new files
· opening existing documents, including over 120 templates
· saving, printing, and exiting
· setting page properties such as the title, background image, 

and text or background colors

Edit Provides standard Windows menu commands for 
· undoing the most recent action and re-doing the action 

affected by the Undo command
· cutting, copying, and pasting text
· selecting, finding, and replacing text
· editing the properties of selected objects
· viewing and editing the HTML Source code 

View Provides menu commands for 
· splitting and refreshing windows
· opening a new window or displaying the document tree
· displaying toolbars in the CorelWEB.DESIGNER window
· enabling/disabling the CorelWEB.DESIGNER bookmark display

Insert Provides menu commands for adding HTML elements and files to
the currently open Web page. These commands include
· inserting forms and form fields
· adding images, horizontal rules, paragraphs, and line breaks
· adding applets written in the Java (TM) Language, 

merging .HTML files, and embedding Internet files
· creating ordered and unordered lists

Format Provides menu commands for specifying HTML formatting of 
text, bookmarks, and hyperlinks.

Table Provides menu commands used to add HTML tables to an active 
Web page or to modify rows, columns, and cells already existing 
in an open document.
· inserting tables, cells, rows, and columns
· selecting and modifying standard table properties
· deleting rows or columns

Tools Provides menu commands that organize your documents and 
launch the other applications included in the 
CorelWEB.GRAPHICS SUITE package. The Tools menu includes 



commands for 
· checking your completed documents for spelling errors
· launching CorelWEB.MOVE, CorelWEB.DRAW, 

CorelWEB.WORLD, CorelWEB.GALLERY, and CorelWEB.Transit
· setting up a server root directory to act as the base location for

all of your Web files
· specifying a browser and previewing your Web pages
· enabling the Welcome on Startup message, the 

CorelWEB.GRAPHICS SUITE application messages, and the 
WEB.DRAW transparency option

Help Provides standard Windows menu commands for accessing all 
online help topics. You can search for specific help topics, 
activate the screen/menu help, browse through the contents 
page or the CorelWEB.DESIGNER tutorial, and access the 
WEB.GRAPHICS SUITE Web Page.

See Also
Using toolbars
HTML tag reference



File menu commands
The File menu offers the following commands:
Command Description
New Opens a new WEB.DESIGNER window.
Open Opens an existing Web page file.
Templates Opens a new Web page based on one of CorelWEB.DESIGNER's template files.
Save Saves the current Web page file.
Save As Names and saves the current Web page file.
Print Setup Selects a printer and printer connection.
Print Prints a Web page file.
Page Properties Opens the Page Properties dialog box, allowing you to display and update your 

page properties.
Exit Exits CorelWEB.DESIGNER.
See Also
CorelWEB.DESIGNER menus
Standard toolbar



Edit menu commands
The Edit menu offers the following commands:
Command Description
Undo Reverses the most recent action.
Redo Reverses the action of the Undo command.
Cut Deletes data from your Web page and copies it to the Windows Clipboard.
Copy Copies data from your Web page to the Windows Clipboard.
Paste Pastes data from the Windows Clipboard into an open Web page.
Clear Deletes data from your Web page without putting it in the Windows Clipboard.
Select All Selects the contents of the current Web page file.
Find Finds the specified text.
Find Next Finds the next instance of the specified text.
Replace Finds the specified text or item and replaces it with the information you specify.
HTML Source Displays the HTML Source for the current Web page.
Properties Displays the current property settings for a selected Web page element.
See Also
CorelWEB.DESIGNER menus
Standard toolbar



View menu commands
The View menu offers the following commands:
Command Description
Split Divides the active window into separate panes, allowing you to view different parts

of the same file simultaneously.
New Window Opens a new window, allowing you to access another Web page or create a new 

file. Using the New Window command, you can open more than one HTML Web 
page simultaneously.

Document Tree Displays the hierarchical structure of HTML formatting tags within a Web page.
Standard Toolbar Shows or hides the Standard toolbar.
Formatting Toolbar Shows or hides the Formatting toolbar.
Style Toolbar Shows or hides the Style toolbar.
Forms Toolbar Shows or hides the Forms toolbar.
Applications Toolbar Shows or hides the Applications toolbar.
Status Bar Shows or hides the Status Bar.
Bookmarks Shows or hides the target bookmarks in an active document.
Refresh Window Redraws the WEB.DESIGNER screen.
See Also
CorelWEB.DESIGNER menus



Insert menu commands
The Insert menu offers the following commands:
Command Description
Form Adds an HTML form to your Web page, corresponding to the HTML <FORM> tag.
Form Field Adds standard HTML form elements to a form. These include text field, text button,

check box, radio button, and list menu items.
Image Adds an image to your Web page, corresponding to the HTML <IMG> tag.
Horizontal Rule Adds a horizontal rule to your Web page, corresponding to the HTML <HR> tag.
Paragraph Inserts a blank space and moves your cursor to a new line on the WEB.DESIGNER 

screen, corresponding to the HTML <P> tag.
Line Break Moves your cursor to a new line on the WEB.DESIGNER screen without inserting a 

space, corresponding to the HTML <BR> tag.
Applet Opens the Applet Properties dialog box to insert Java Powered (TM) applets and 

specify Applet and Parameter values, including class, alternate text, spacing, 
alignment, and scaling properties. The Applet command corresponds to the HTML 
<APPLET> tag.

HTML File Opens the Select File dialog box to insert and merge an existing .HTML file with the
current CorelWEB.DESIGNER document. This command applies to all .HTML files, 
including those containing applets.

Embedded file Opens the Embedded File Properties dialog box to insert an external Internet file in
your current WEB.DESIGNER page. Although the Embedded file command can be 
used with files of all types, most embedded objects can only be viewed with 
application specific plug-ins.

Ordered List Adds an ordered list to your current document, corresponding to the HTML <OL> 
tag used with the <LI> tag.

Unordered List Adds an unordered list to your current document, corresponding to the HTML 
<UL> tag used with the <LI> tag.

Notes
· When inserting applets in CorelWEB.DESIGNER, you must copy all referenced files for the applet, including the 

corresponding images and classes.
· The Forms toolbar provides the same options for creating forms and specifying form fields as those appearing 

in the Insert menu.
See Also
CorelWEB.DESIGNER menus
Forms toolbar
Formatting toolbar
Standard toolbar



Format menu commands
The Format menu offers the following commands:
Command Description
Normal Removes existing HTML tags, returning text to the normal font display.
Heading Specifies a Heading paragraph style, corresponding to HTML tags <H1> through 

<H6>.
Preformatted text Specifies a preformatted paragraph style, corresponding to the HTML <PRE> tag.
Block Quotation Specifies a Block Quotation paragraph style, corresponding to the HTML 

<BLOCKQUOTE> tag.
Ordered List Places selected text in an ordered (numbered) list, corresponding to the HTML 

<OL> tag used with the <LI> tag.
Unordered List Places selected text in an unordered (bulleted) list, corresponding to the HTML 

<UL> tag used with the <LI> tag.
Hyperlink Formats the selected text or image as a hyperlink jump, corresponding to the 

HTML <A HREF> tag.
Bookmark Formats the selected text or image as bookmark, corresponding to the HTML <A 

NAME> tag.
See Also
CorelWEB.DESIGNER menus
Formatting toolbar



Table menu commands
The Table menu offers the following commands:
Command Description
Insert Table Opens the Table Properties dialog box, corresponding to the HTML <TABLE> tag.
Insert Cell Adds a cell to the table, corresponding to the HTML <TD> tag.
Insert Rows/Columns Adds a row or column to the table. The Insert Rows command corresponds to the 

HTML <TR> tag. The Insert Columns command corresponds to the HTML COLSPAN
attribute with the table data tag <TD>.

Delete Cell Deletes a cell from a row in the current table.
Delete Row Deletes a row from all columns in the current table.
Delete Column Deletes a column from all rows in the current table.
Select Cell Selects a table cell for modification.
Select Row Selects a table row for modification.
Select Table Selects the entire table and its contents for modification.
Cell Properties Opens the Cell Properties dialog box allowing you to adjust cell size, type, and 

alignment.
Table Properties Opens the Table Properties dialog box, allowing you to adjust the table width, 

alignment, spacing, and layout.
Note
· All table menu commands, except Insert Table, are only available if your cursor is positioned inside an active 

table.
See Also
CorelWEB.DESIGNER menus
Designing tables
Creating a new table
Specifying boundaries in the Table Properties dialog box
Setting your table's background color



Tools menu commands
The Tools menu offers the following commands:
Command Description
Spelling Check Verifies the spelling of all text in your Web page.
CorelWEB.MOVE Launches the CorelWEB.MOVE application from the WEB.DESIGNER window.
CorelWEB.DRAW Launches the CorelWEB.DRAW application from the WEB.DESIGNER window.
CorelWEB.WORLD Launches the CorelWEB.WORLD application from the WEB.DESIGNER window.
CorelWEB.GALLERY Launches the CorelWEB.GALLERY application from the WEB.DESIGNER window.
CorelWEB.Transit Launches the CorelWEB.Transit application from the WEB.DESIGNER window.
Browser Preview Launches an HTML browser from the WEB.DESIGNER window, allowing you to 

preview your current document on the World Wide Web.
Set Browser Opens the Select HTML Browser dialog box, allowing you to specify the browser 

that you want to use to preview your WEB.DESIGNER documents.
Set Server Root Specifies a directory as your server root or base directory. The server root 

directory stores all the .HTML and graphics files that you use in your Web pages.
Options Allows you to enable or disable the Welcome on Startup screen, the 

CorelWEB.GRAPHICS SUITE application launch messages, the Enable lower case 
file names option, and the WEB.DRAW transparency option.

See Also
CorelWEB.DESIGNER menus
Applications toolbar



Help menu commands
The Help menu offers the following commands to provide assistance with the WEB.DESIGNER application:

Command Description
Contents Provides an entry point to task-oriented help topics.

Screen/Menu Help Displays context-sensitive help for buttons, menu items, and 
window displays.

Search For Help On Provides an index to all help topics.

Technical Support Displays technical support or customer service information.

Tutorial Opens the CorelWEB.DESIGNER tutorial — a hands-on approach to 
learning CorelWEB.DESIGNER.

WEB.GRAPHICS SUITE 
Web Page

Opens the WEB.GRAPHICS SUITE Web Page directly from the 
WEB.DESIGNER window.

About 
CorelWEB.DESIGNER

Displays the application version number and registration 
information.

See Also
CorelWEB.DESIGNER menus
Standard toolbar



Publishing files to WEB.DESIGNER
Files created in the other CorelWEB.GRAPHICS SUITE applications can be easily merged with WEB.DESIGNER 
documents, allowing you to integrate applications and resulting in advanced World Wide Web pages. 
WEB.DESIGNER offers the following publishing options:
Inserting animations
Creating and inserting your own graphics
Inserting VRML
Adding WEB.GALLERY images
Converting word processing files
See Also
Adding sound
Merging .HTML files
Inserting Java powered (TM) applets
Embedding files



Merging .HTML files
In the CorelWEB.GRAPHICS Suite of applications, merging .HTML files is performed by the Insert, HTML File 
command.

To merge existing .HTML files into your open WEB.DESIGNER page
1. Click Insert, HTML File.

CorelWEB.DESIGNER opens the Select File dialog box.
2. Search the drives, directories, and folders of your local system for the .HTML file that you want to insert in your

WEB.DESIGNER page.
3. Select the .HTML file and click OK.
Note
· The Insert, HTML file command merges .HTML files that contain applets, providing an alternative to the Insert, 

Applet command.

See also
Publishing files to WEB.DESIGNER



Inserting Java Powered (TM) Applets
In the CorelWEB.GRAPHICS Suite of applications, inserting applets is performed by the Applet command in the 
WEB.DESIGNER Insert menu.

To insert Applet Classes
1. Click Insert, Applet.

WEB.DESIGNER opens the Applet Properties dialog box.
2. Click Browse.

WEB.DESIGNER opens the Select Class File dialog box.
3. Select the applet's .CLASS file and click Open.
4. Specify values for each of the properties listed in the Applet Properties dialog box to control the appearance of 

the applet file on your WEB.DESIGNER page.
5. Click OK.
Note
· You can also add Java Powered applets contained in .HTML files to your WEB.DESIGNER page by clicking Insert,

HTML file. The entire .HTML file and its contents will be merged with the open WEB.DESIGNER document.

See Also
Publishing files to WEB.DESIGNER
Publishing in the Java Programming Language (TM) with Barista
Barista files



Embedding files
CorelWEB.DESIGNER's Embedded File command empowers you with one of the most advanced integration 
techniques offered on the Net. Embedding files allows you to insert Internet files of all types into your Web 
documents. These files can include audio, video, animation, and any other objects that can be viewed directly in 
a Web browser or with the help of a plug-in application.

To embed an Internet file in your WEB.DESIGNER document
1. Position your cursor at the point on your WEB.DESIGNER page where you want to embed a file.
2. Click Insert, Embedded File.

WEB.DESIGNER produces the Embedded File Properties dialog box.
3. Type the directory path for the file in the Embedded File field or click Browse to locate the file on your local 

system.
4. Set the embedded file's spacing, alignment, and scaling values in the Embedded File Properties dialog box.
5. Click OK.
When you embed Internet files in your HTML document, WEB.DESIGNER inserts a system icon, representing the 
type of file that you inserted. To see how a browser displays the embedded file, preview your WEB.DESIGNER 
document using the Tools, Browser Preview command. The appearance of embedded files on the Web varies 
according to the type of browser and plug-in applications that access the file.
Notes
· The Embedding File command can be used to insert external files that you have stored on your local system, 

but should not be used to insert standard HTML elements such as .GIF and .JPG files, which are added to 
WEB.DESIGNER documents with the Insert Image command, or .HTML files which are best integrated using the
HTML File command.

· If your embedded file can only be viewed with the help of a browser plug-in application, insert a hypertext link 
directing your visitors to the appropriate online downloading location. Netscape 2.0 plug-ins are available at 
http://home.netscape.com/comprod/mirror/navcomponents_download.html. You can also direct your 
visitors to the Netscape home page (http://home.netscape.com), where they will find links to the 
downloading site. Microsoft's Internet Explorer plug-ins are available at 
http://www.microsoft.com/ie/addons/default.htm or through the Software Library from the Microsoft 
home page (http://www.microsoft.com).

· Publishing a file to WEB.DESIGNER from one of the other CorelWEB.GRAPHICS SUITE applications automatically
embeds the file in your current WEB.DESIGNER document. For example, if you have created a .WRL file using 
CorelWEB.WORLD, clicking File, Publish to WEB.DESIGNER embeds the .WRL file directly into your current Web 
page.

See Also
Publishing files to WEB.DESIGNER
Viewing your Web pages
Viewing VRML



Inserting animations
In the CorelWEB.GRAPHICS Suite of applications, the creation and integration of animated files is performed by 
the CorelWEB.MOVE command in the WEB.DESIGNER Tools menu and the Publish to command in the 
CorelWEB.MOVE File menu.

To insert animations in your Web page
1. Position your cursor at the point in your WEB.DESIGNER document where you want to insert an animation.
2. Click Tools, CorelWEB.MOVE.

WEB.MOVE is launched directly from the WEB.DESIGNER window.
3. Create an animation using the tools and commands offered by the CorelWEB.MOVE menus and toolbars. Refer 

to the WEB.MOVE online Help system for assistance in constructing your animated files.
4. Click File, Publish to WEB.DESIGNER.

WEB.DESIGNER closes the WEB.MOVE window and adds the animation to your Web page.
Notes
· When the first frame of your animation appears in the WEB.DESIGNER window, you can double-click the image

or click Edit, Properties to open the Applet Properties dialog box.
· To automatically publish an animation to the WEB.DESIGNER page, you must launch CorelWEB.MOVE from 

within WEB.DESIGNER.
· To insert an animated GIF into WEB.DESIGNER, click Insert, Image and then click Browse to locate the file.

See Also
Publishing files to WEB.DESIGNER
Barista files
Viewing your Web pages
Using animations



Creating and inserting your own graphics
In the CorelWEB.GRAPHICS Suite of applications, the creation and integration of graphic images is performed by 
the CorelWEB.DRAW command in the WEB.DESIGNER Tools menu and the Publish to command in the 
CorelWEB.DRAW File menu.

To create and insert WEB.DRAW graphics
1. Position your cursor at the point in your WEB.DESIGNER document where you want to insert a WEB.DRAW 

graphic.
2. Click Tools, CorelWEB.DRAW.

WEB.DRAW is launched directly from the WEB.DESIGNER window.
3. Create a graphic using the tools and commands offered by the CorelWEB.DRAW menus and toolbars. Refer to 

the WEB.DRAW online Help system for assistance in constructing your graphic files.
4. Click File, Publish to WEB.DESIGNER.

WEB.DESIGNER closes the WEB.DRAW window and adds the graphic to your Web page.
Notes
· You can also insert any existing graphics into your Web page by clicking Insert, Image from the WEB.DESIGNER

menu.
· To automatically publish a WEB.DRAW image to your WEB.DESIGNER page, you must launch CorelWEB.DRAW 

from within WEB.DESIGNER.
· When the first frame of your image appears in the WEB.DESIGNER window, you can double-click the image or 

choose Edit, Properties to open the Image Properties dialog box.

See Also
Publishing files to WEB.DESIGNER
Inserting images



Inserting VRML
You can create VRML and merge them with your World Wide Web pages using WEB.DESIGNER's 
CorelWEB.WORLD command and WEB.WORLD's Publish to WEB.DESIGNER command.

To create and insert WEB.WORLD VRML
1. Position your cursor at the point in your WEB.DESIGNER document where you want to insert VRML.
2. Click Tools, CorelWEB.WORLD.

WEB.WORLD is launched directly from the WEB.DESIGNER window.
3. Create a VRML using the tools and commands offered by the WEB.WORLD menus and toolbars. Refer to the 

WEB.WORLD online Help system for assistance in constructing your VRML file.
4. Click File, Publish to WEB.DESIGNER.

WEB.DESIGNER closes the WEB.WORLD window and adds the VRML to your Web page.
Notes
· To view a virtual world, your browser must have VRML viewer support. This is achieved either as a free plug-in 

(e.g., Live 3D for Netscape Navigator 2.0) or built in support (e.g., Netscape Navigator 3.0, Internet Explorer 
3.0).

· You can double-click the VRML or click Edit, Properties to open the Embedded File Properties dialog box.
· To automatically publish your VRML to the WEB.DESIGNER page, you must launch CorelWEB.WORLD from 

within WEB.DESIGNER.

See Also
Publishing files to WEB.DESIGNER
Viewing your Web pages
Viewing VRML



Adding WEB.GALLERY images
Almost anyone can create a World Wide Web page, but not everyone has the artistic talent or time necessary to 
create images for those pages. The CorelWEB.GRAPHICS SUITE of applications includes CorelWEB.GALLERY to 
supply you with thousands of ready-to-use images for integration in your WEB.DESIGNER pages. Simply drag and
drop images to your CorelWEB.DESIGNER screen and give color and life to your documents.

To add a WEB.GALLERY graphic
1. Position your cursor at the point on your WEB.DESIGNER screen where you want to insert a graphic.
2. Click Tools, CorelWEB.GALLERY.

WEB.GALLERY is launched directly from the WEB.DESIGNER window.
3. Locate the image(s) that you want to appear in your Web page by browsing through the WEB.GALLERY albums.
4. Drag and drop the image(s) onto your open WEB.DESIGNER document.
Notes
· Any pre-created image can be inserted into your Web page by clicking Insert, Image from the WEB.DESIGNER 

menu.
· CorelWEB.DESIGNER handles .JPG and .GIF file formats directly. Three other file formats, (.TGA, .BMP, 

and .PCX) will automatically be converted to .GIF or .JPG file formats when they are inserted in the 
WEB.DESIGNER page.

See Also
Publishing files to WEB.DESIGNER
Inserting images



Converting word processing files
Appealing World Wide Web pages successfully combine the visual enhancements of graphics and the clarity of 
text to attract audiences. Because you create most text based files with a word processing mechanism, 
CorelWEB.DESIGNER allows you to translate word processing files to HTML using CorelWEB.Transit. You can then 
edit the page’s final appearance and content using CorelWEB.DESIGNER.

To insert a word processing file in WEB.DESIGNER
1. Click Tools, CorelWEB.Transit.

WEB.Transit is launched directly from the WEB.DESIGNER window.
2. Click Set Up Files and locate your word processing file.
3. Choose the output directory for the .HTML file.
4. Click Translate Publication.
5. Click the Edit Publication button on the WEB.Transit opening screen to load the converted .HTML file into a new

CorelWEB.DESIGNER window.
Note
· Once your word processing file is converted to an .HTML file, you can open it in WEB.DESIGNER by clicking File,

Open and locating the converted file. You can also insert the converted .HTML file in WEB.DESIGNER by 
choosing the HTML File command from the Insert menu and locating the file name.

See Also
Publishing files to WEB.DESIGNER



Size

Converts your mouse pointer to a four-headed arrow, allowing you to size the active window with the arrow keys 
on your keyboard.

To size your WEB.DESIGNER window, right-click the title bar and choose Size from the drop-down menu. Press the 
left, right, up or down arrow keys to move the pointer to the border being sized. Move your mouse to adjust your 
screen size and left-click or press ENTER [key] to fix the new settings. This command is unavailable if you maximize 
the window.



Move

Converts your mouse to a four-headed arrow, allowing you to reposition an active window or dialog box.

To move your WEB.DESIGNER window, right-click on the title bar and choose Move from the drop-down menu. Press 
the left, right, up, or down arrow keys and reposition your window by moving your mouse. Left-click or press ENTER 
[key] to fix the new setting. This command is unavailable if you maximize the window. You can also move the 
WEB.DESIGNER window by pressing CTRL+F7.



Minimize

Collapses the CorelWEB.DESIGNER window. You can also minimize the current WEB.DESIGNER window by clicking
 on the title bar.



Maximize

Expands the WEB.DESIGNER window. You can also maximize the CorelWEB.DESIGNER window by clicking  on 
the title bar.



Close

Closes an active window or dialog box. You can also close the CorelWEB.DESIGNER window or a dialog box by 
pressing ALT+F4. To close a drop-down menu, double-click the control-menu box.



Restore

Removes the effects of the minimize or maximize command, returning the active WEB.DESIGNER window to its 
original size and position.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Status Bar

Displays command or toolbar functions at the bottom of the CorelWEB.DESIGNER window. To show or hide the 
Status Bar, click View, Status Bar.
CAP Enables the Caps Lock function. 
NUM Enables the Num Lock function. 
SCRL Enables the Scroll Lock function.



Title bar

Displays the application and document names across the top of a window. Click and drag the title bar to move a 
window or dialog box. A title bar displays the following elements:
· application and document control-menu buttons
· minimize, maximize and restore buttons
· name of the application and document



Scroll bars

Indicate the vertical and horizontal location of your mouse in a current document. You can click the left and right 
or up and down scroll bars to quickly move throughout your document.



Insert Table

Opens the Table Properties dialog box, allowing you to define the settings and appearance of a new table in 
WEB.DESIGNER page.



Insert Cell

Adds a cell to the table at your current cursor position. The Insert Cell command is not available when your 
cursor lies outside of the table's border.



Insert Rows/Columns

Adds a row or column to the table at your current cursor position. The Insert Rows/Columns command is not 
available when your cursor lies outside of the table's border.



Insert Rows/Columns dialog box 
Defines the number and placement of the rows or columns you want to add to your table.

Insert Rows
Number of Rows Specifies the number of rows to add to the current table.
Above selection Places the rows above your current cursor position.
Below selection Places the rows below your current cursor position.

Insert Columns
Number of Columns Specifies the number of columns to add to the current table.
Left of selection Places the columns to the left of your current cursor position.
Right of selection Places the columns to the right of your current cursor position.



Delete Cell

Deletes a selected cell from the current table. If you do not select the cell, WEB.DESIGNER deletes the cell 
indicated by your current cursor position. The Delete Cell command is not available when your cursor lies outside
of the table's border.



Delete Row

Deletes a selected row from the current table. If you do not select the row, WEB.DESIGNER deletes the row 
indicated by your current cursor position. The Delete Row command is not available when your cursor lies 
outside of the table's border.



Delete Column

Deletes a column from all rows in the current table. The Delete Column command is not available when your 
cursor lies outside of the table's border.



Select Cell

Selects the cell indicated by your current cursor position. You must select cells before you can modify their 
properties. The Select Cell command is not available when your cursor lies outside of the table's border.



Select Row

Selects the row indicated by your current cursor position. You must select a row before you can modify its 
properties. The Select Row command is not available when your cursor lies outside of the table's border.



Select Table

Selects the entire table and its contents. Most often, the Select Table command is used to align a table on your 
WEB.DESIGNER page, but clicking Table, Select Table can also be used to delete a table and its contents from 
your screen. The Select Table command is not available when your cursor lies outside of the table's border.



Cell Properties

Opens the Cell Properties dialog box, allowing you to adjust a selected cell's size and layout. The Cell Properties 
dialog box controls a cell's width, type, and alignment. The Cell Properties command is not available when your 
cursor lies outside of the table's border.



Cell Properties dialog box 
Defines the properties of the cells contained in your table and can be accessed by clicking Table, Cell Properties.

Minimum Width
Specify Width Allows you to specify the width of a selected cell in pixel or percentage format.
in Pixel Displays the cell width in pixels.
in Percent Displays the cell width as a percentage of the table width.

Alignment
Horizontal Specifies the horizontal alignment of a cell's contents.
Vertical Specifies the vertical alignment of a cell's contents.

Cell Type
Data Displays cell contents in normal font.
Header Displays cell contents in bold font. Create header cells in the top row of your table 

to give a label or title to each corresponding column.
Note
· Disabling the width check box allows the cell to size according to its contents.



Table Properties dialog box
Regulates the number of rows and columns appearing in your table, as well as the size, alignment, spacing, and 
layout of the table's elements. The Table Properties dialog appears when you choose Table, Insert Table or Table, 

Table Properties, or when you click .

Number of 
Rows Specifies the number of rows in the current table.
Columns Specifies the number of columns in the current table.

Width
Specify Width Specifies the width of the current table on your WEB.DESIGNER page.
in Pixels Specifies the width of the current table in pixel format.
in Percent Specifies the width of the current table as a percentage of the WEB.DESIGNER 

page.

Alignment
Aligns the table to the left, right, or center of the WEB.DESIGNER screen. The WEB.DESIGNER alignment option 
defaults to the left margin.

Layout
Border Size Specifies the current table's border size in pixels. If you set your border size value 

to zero, WEB.DESIGNER surrounds the table with a dotted line but no border 
appears in your Web browser.

Cell Padding Specifies the size of the space between a cell wall and its contents.
Cell Spacing Specifies the size of the space between cells in a table.
Notes
· Disabling the width check box allows cells to size according to their contents.
· The WEB.DESIGNER border, cell padding, and cell spacing values default to zero.



Table Properties

Opens the Table Properties dialog box, allowing you to define the number of rows and columns contained within 
your table's boundaries, the width of the table, its alignment, layout, cell padding, and cell spacing. The Table 

Properties dialog box appears when you click , Table, Insert Table, or Table, Table Properties. The Table 
Properties command is not available when your cursor lies outside of the table's border.



Designing tables
Using the CorelWEB.DESIGNER table functions, you can create organizational charts, calendars, schedules, and 
more. Customized layout, alignment, and sizing options allow you to produce unique, structured pages that 
appeal to your audience.
Note
· Your table's cells can hold most HTML elements, and while textual inserts remain the most popular, online 

tables can also integrate images, image maps, and other tables.

See Also
Creating a new table
Modifying table elements
Specifying boundaries in the Table Properties dialog box
Setting your table's background color
Table menu



Creating a new table
With CorelWEB.DESIGNER's Insert Table command or toolbar button, you can add sophisticated HTML tables to 
your Web pages.

To create a new table
1. Position your cursor at the point on your WEB.DESIGNER page where you want to insert the table.

2. Click Table, Insert Table or click .
WEB.DESIGNER opens the Table Properties dialog box.

Note
· The Table Properties dialog box, produced by clicking Table, Insert Table, displays the default options for each 

listed table property. The dialog box produced by clicking Table, Table Properties from within a current table, 
allows you to modify only the table's alignment, width, and layout attributes. You can alter the number of rows 
and columns in a table using the Insert and Select commands.

See Also
Designing tables
Modifying table elements
Specifying boundaries in the Table Properties dialog box
Setting your table's background color
Table menu



Specifying boundaries in the Table Properties dialog box
Once you have added a basic table structure to your WEB.DESIGNER document, you can customize the table's 
attributes to suit the data it will display on the Web.

To specify boundaries in the Table Properties dialog box
1. Determine the number of rows and columns that best present your table's material and type the 

corresponding digits in the Table Properties dialog box.
2. Set the width of your table in pixel or percentage format. Disabling the width check box allows the cells to size 

according to their contents.
3. Select an alignment for your table from the Alignment list box.

The WEB.DESIGNER alignment option defaults to the left margin.
4. Modify the table's border, cell padding, and cell spacing by inserting pixel values in the appropriate fields.
Notes
· Because the primary function of all tables is to present data in a concise, attractive manner, it's important to 

test your table's appearance by inserting alternate values and choosing the most appealing format. To choose 
the most effective values for your table's boundaries, insert digits and preview the results until you achieve 
the best appearance.

· If you specify zero as the table border value in the Table Properties dialog box, WEB.DESIGNER surrounds your 
table with a dotted line, but no border will appear in your Web browser window. The table border value 
defaults to zero.

· Avoid setting a cell padding of zero on a table with borders to prevent the edges of your text from touching the
cell borders. The WEB.DESIGNER cell padding option in the Table Properties dialog box defaults to zero.

See Also
Designing tables
Creating a new table
Modifying table elements
Setting your table's background color
Table menu



Modifying table elements
Once you have created a table in WEB.DESIGNER, you can edit or modify its properties by clicking Table, Table 
Properties and editing its contents. However, some alterations including adding cells, rows, and columns can 
only be performed with additional menu commands.
Add cells to your table
Add rows or columns to your table
To select cells or rows
To delete rows or columns
To delete cells
To select a table
Note
· Cells, rows, and columns can be inserted or deleted by right clicking inside the table and choosing the 

appropriate command from the pop-up menu.

See Also
Designing tables
Creating a new table
Specifying boundaries in the Table Properties dialog box
Setting your table's background color
Table menu



To add cells to a current table

1. Position your cursor at the point within the table where you want to insert an additional cell.
2. Click Table, Insert Cell.



To add rows or columns to a current table

1. Position your cursor at the point in your table where you want to insert an additional row or column.
2. Click Table, Insert Rows/Columns.

WEB.DESIGNER opens the Insert Rows/Columns dialog box.
3. Enable the Insert Rows or the Insert Columns check box.
4. Specify the number and placement of the rows or columns that you want to insert.
5. Click OK.



To select cells or rows

1. Position your cursor inside the cell or row that you want to select.
2. Click Table, Select Cell or Table, Select Row.

WEB.DESIGNER selects the corresponding portion of the table.
3. Modify the cell or row, or click any point of the CorelWEB.DESIGNER screen to cancel the selection.



To delete rows or columns

1. Position your cursor in the row or column that you want to delete.
2. Click Table, Delete Row or click Table, Delete Column.



To delete cells

1. Position your cursor inside the cell you want to delete.
2. Click Table, Delete Cell.



To select a table

· Position your cursor inside the table, and click Table, Select Table.
WEB.DESIGNER selects the entire table and its contents.



Setting your table's background color
Once you have created and modified your table's structure, you can use CorelWEB.DESIGNER's advanced 
coloring applications to change the background color of your table's cells and rows, or of the entire table 
structure.

To adjust the background color of your online table
1. Select the cell or row you want to color or click Table, Select Table to select the entire table.

2. Click .
3. Choose a color from the Font/Cell color list box.

Note

· To customize the color of your table's background, click  and choose Custom Color. WEB.DESIGNER opens 
a Color dialog box that allows you to specify the exact shade of your table's background.

See Also
Designing tables
Creating a new table
Modifying table elements
Specifying boundaries in the Table Properties dialog box
Table menu



Tips for using WEB.DESIGNER's most popular features
Creating a Web page for the first time can be intimidating — choosing the appropriate software, manuals, 
tutorials, and procedures takes time and often leaves you wondering where to begin. But even more experienced
users can stumble the first time they open a new Web editing program and begin to familiarize themselves with 
foreign authoring techniques and design approaches.
The following tips and tricks condense and simplify the most popular WEB.DESIGNER procedures to provide both 
experienced and novice Web artists with a starting point for their designs. You can find more information about 
any of the following procedures in Using CorelWEB.DESIGNER.
Opening a WEB.DESIGNER template
Changing a heading size
Setting a hyperlink
Setting a bookmark
Linking to a bookmark
Creating a bulleted list
Changing text color
Setting background color
Setting a background image
Inserting an image
Merging an .HTML file
Changing an object's properties
Setting a default browser
Previewing your WEB.DESIGNER document
Launching other WEB.GRAPHICS SUITE applications
Publishing from other WEB.GRAPHICS SUITE applications
Notes
· The first time you select the Browser Preview command, you must specify the location of your browser's .EXE 

file.
· To customize your text or cell background colors, click the Font/Cell Color tool and choose Custom Color.
· If you click Browse to locate your background image, WEB.DESIGNER opens the Select Image Source dialog 

box and lists the .GIF files used for the template pages.
· CorelWEB.DESIGNER handles .GIF and .JPG file formats directly. Three other file formats (.TGA, .BMP, and .PCX) 

will automatically be converted to .GIF or .JPG file format when you insert them in your Web page.

See Also
CorelWEB.DESIGNER basics
CorelWEB.DESIGNER screen tour
CorelWEB.DESIGNER tools
Using CorelWEB.DESIGNER
Glossary of terms



To open a WEB.DESIGNER template

1. Click File, Templates
2. Double-click an .HTM file to open the page in WEB.DESIGNER.



To change a heading size

1. Select the text you want to appear in heading format.
2. Click Format, Heading and choose from Heading 1 - Heading 6.



To set a hyperlink

1. Select the hyperlink text.
2. Click Format, Hyperlink and type the URL of the target destination or click Browse to locate a target that 

resides on your local system.



To set a bookmark

1. Select the target text or image.
2. Click Format, Bookmark and type an identifiable name for your selection.



To link to a bookmark

1. Select the text or image to use as a hotspot for the jump.
2. Click Format, Hyperlink and open the bookmark tab.
3. Select the name of the target bookmark from the generated list.



To create a bulleted list

1. Click Insert, Unordered List.
2. Type the text for your list's first entry and press ENTER [key].
3. Repeat Step 2 until the list is complete and press ENTER [key] twice.



To change text color

1. Select the text you want to color and click .
2. Choose a color from the Font/Cell color list box.



To set a background color

1. Click File, Page Properties.
2. Choose a color from the Background Colors list box.



To specify a background image

1. Click File, Page Properties.
2. Type the directory path for your background image or click Browse to locate the file.



To insert an image

1. Click Insert, Image to open the Image Properties dialog box.
2. Type the directory path for the image you want to add to your Web page or click Browse to locate the file.
3. Modify the alignment, spacing, and scaling of your image in the Image Properties dialog box.



To merge an .HTML File

1. Click Insert, HTML File.
2. Locate the file and click OK.



To change an object's properties

1. Double-click the object or select the object and click Edit, Properties.
WEB.DESIGNER opens the object's properties dialog box.

2. Make the appropriate changes to properties such as alignment, spacing, scaling, or alternate text.



To set a default browser

1. Click Tools, Set Browser.
WEB.DESIGNER opens the Select HTML Browser dialog box.

2. Type the directory path for the browser that you want to specify as the default or click Browse to locate the 
browser application.



To preview your WEB.DESIGNER document

· Click Tools, Browser Preview or choose  from the Standard toolbar.



To launch other CorelWEB.GRAPHICS SUITE applications from within WEB.DESIGNER

· Click Tools and choose the application that you want to launch.



To publish work from other CorelWEB.GRAPHICS SUITE applications back to WEB.DESIGNER

· Click File, Publish to WEB.DESIGNER in the other application.



HTML tag reference
CorelWEB.DESIGNER allows you to create HTML Web pages without ever having to edit a single line of HTML 
code. However, if you’re already familiar with HTML, here is a list of standard HTML tags, popular extensions, and
a description of their function in CorelWEB.DESIGNER.

HTML Tag Icon Description CorelWEB.DESIGNER Operation
<A HREF=> Hyperlink Formats the selected text or object as a 

hyperlink. You can also click Format, 
Hyperlink to create a jump.

<ABBREV> Abbreviation Applies the abbreviation attribute to 
selected text.

<ACRONYM> Acronym Applies the acronym attribute to 
selected text.

ALIGN=CENT
ER or 
<CENTER>

Align Center Centers selected text.

<APPLET> N/A Applet Inserts a pre-designed Java Powered 
(TM) applet.

<AU> Author Applies the author attribute to selected 
text.

<B> Bold Applies the boldface attribute to 
selected text.

<BLOCKQUO
TE>

N/A Block quotation Applies the Block Quotation style in the 
Style selection list of the Formatting 
toolbar. You can also click Format, Block 
Quotation to specify this tag.

<BR> Line Break Inserts a line break.

<CITE> Citation Applies the citation attribute to selected 
text.

<CODE> Example Code Applies the example code attribute to 
selected text.

<DEL> Deleted Text Applies the deleted text attribute to 
selected text.

<DFN> Definition Applies the term definition attribute to 
selected text.

<EM> Emphasis Applies the emphasis attribute to 
selected text.

<FONT 
COLOR=>

Font/Cell Color Specifies a color attribute to add to 
selected text.

<FONT 
FACE=>

N/A Font Typeface Specifies a font typeface to display 
selected text.

<FONT N/A Font Size Specifies font size (from 1 to 7) or font 



SIZE=> size relative to the current text size (+/-
7) from the Font size list on the 
Formatting toolbar. 

<H1>, <H2>,
<H3>, <H4>,
<H5>, <H6>

N/A Heading 1 
through 6

Formats selected text in heading style. 
Click Format, Heading to add heading 
styles to your document.

<HR> N/A Horizontal Rule Selects the Horizontal Rule option from 
the Insert menu and inserts a horizontal 
rule.

<I> Italic Applies the italics attribute to selected 
text.

<IMG> N/A Image Selects the Image option from the Insert
menu.

<INS> Inserted Text Applies the inserted text attribute to 
selected text.

<KBD> Typed Text Applies the keyboard or typed text 
attribute to selected text.

<OL>, <LI> Ordered List Creates an ordered (numbered) list from
selected paragraphs. You can also click 
Format, Ordered List to create an 
ordered list from selected paragraphs. 
You can create a new ordered list by 
clicking Insert, Ordered List.

<P> N/A Paragraph Inserts a new paragraph.

<P 
ALIGN=RIGHT
>

Align Right Specifies right alignment of a selected 
paragraph.

<P 
ALIGN=LEFT
>

Align Left Specifies left alignment of a selected 
paragraph.

<PERSON> Surname or 
Person

Applies the person attribute to selected 
text.

<PRE> N/A Preformatted Selects Preformatted in the Style 
Selection list of the Formatting toolbar. 
You can also click Format, Preformatted 
Text to specify this tag.

<Q> Short Quotation Applies the short quotation attribute to 
selected text.

<S> Strike-through Applies the strike-through attribute to 
selected text.

<SAMP> Literal (Sample) Applies the sample attribute to selected 
text, corresponding to the <SAMP> tag.

<STRONG> Strong 
Emphasis

Applies the strong emphasis attribute to 
selected text.



<TT> Typewritten or 
Teletype

Applies the typewritten or teletype 
attribute to selected text.

<U> Underline Applies the underline attribute to 
selected text.

 <UL>, <LI> Unordered List Creates an unordered (bulleted) list from
selected paragraphs. You can also 
choose Format, Unordered List to create 
an unordered list from selected 
paragraphs. You can create a new 
unordered list by clicking Insert, 
Unordered List.

<VAR> Variable Applies the variable attribute to selected
text.

HTML 
Forms:
<FORM> Form Creates a new form. You can also create 

a new form by choosing Insert, Form.

<INPUT 
TYPE="text">

Text field Creates a new text field. You can also 
create a new text field on a form by 
clicking Insert, Form Field Text Field.

 <INPUT 
TYPE="submi
t"

Button Creates a new button. You can also 
create a new button on a form by 
clicking Insert, Form Field Button.

<INPUT 
TYPE= 
"checkbox">

Check Box Creates a new check box field. You can 
also create a new check box field on a 
form by choosing Insert, Form Field 
Check Box Field.

<INPUT 
TYPE= 
"radio">

Radio button Creates a new radio button. You can also
create a new radio button on a form by 
clicking Insert, Form Field Radio Button.

<SELECT> Selection list or 
menu

Creates a new selection list or menu. 
You can also create a new selection list 
or menu on a form by clicking Insert, 
Form Field List/Menu.

HTML 
Tables:
<TABLE> Table Opens the Table Properties dialog box to

insert a table. You can also create a 
table by clicking Table, Insert Table.

BORDER N/A Table Border Regulates the size of the border that 
outlines your table's cells in pixels, 
acting as an HTML attribute to the 
<TABLE> command (<TABLE 
BORDER="x">). If you specify zero as 
the border value, WEB.DESIGNER 
surrounds your table with a dotted line, 
but no border will appear in your Web 
browser window. The table border value 



defaults to zero.

CELLPADDING N/A Cell Padding Regulates the amount of space between
the edge of a cell and its contents in 
pixels. Avoid setting a cell padding of 
zero on a table with borders to prevent 
the edges of your text from touching the
cell borders. CELLPADDING acts as a 
HTML attribute to the <TABLE> 
command, appearing as <TABLE 
CELLPADDING="x">. The cellpadding 
attribute defaults to zero.

CELLSPACING N/A Cell Spacing Regulates the amount of space between
individual cells in a table and between a 
table's cells and the border. The 
WEB.DESIGNER cellspacing value 
defaults to zero.

ALIGN N/A Table Alignment Aligns your table on the 
CorelWEB.DESIGNER screen, offering 
left, right, center and default alignment 
options. The default setting aligns your 
table to the left margin of the 
WEB.DESIGNER screen.

WIDTH N/A Table Width Regulates the amount of space that your
table occupies across the width of the 
page. WIDTH may be set in pixel or 
percentage format and acts as an 
attribute to the <TABLE> command in 
HTML, appearing as <TABLE 
WIDTH="x">.

<TR></TR> N/A Table Row Adds a row to the table in your active 
document. The number of TR entries 
listed in the HTML Source code directly 
corresponds to the number of rows 
specified in the Table Properties dialog 
box.

<TD></TD> N/A Data Cell Specifies a standard table data cell and 
only appears within the <TR> and 
</TR> container tags in HTML. If you 
specify different numbers of cells in 
each row, WEB.DESIGNER pads shorter 
rows with blank cells. A cell can contain 
any of the HTML elements normally 
present in the body of a Web page.

<TH></TH> N/A Header Cell Specifies a standard table header cell 
and only appears within the <TR> and 
</TR> container tags in HTML. Text 
contained in the header cell is displayed
in bold font.

Note
· Some of the HTML tags you can specify with CorelWEB.DESIGNER may not be supported by all Web browsers 

and may simply be ignored.



See Also
CorelWEB.DESIGNER menus
Using toolbars



Using toolbars
CorelWEB.DESIGNER's toolbars allow you to quickly access the application's most common authoring commands.
You can hide or display the WEB.DESIGNER toolbars by enabling or disabling them in the View menu.

Toolbar Description
Standard Toolbar Provides functions to 

· create a new file or open an existing document
· save, find, cut, copy, and paste text
· spell check and print files
· edit HTML Source code
· view the Web document tree structure
· insert an image, hyperlink, horizontal rule, or table
· access the Image Map Editor and Screen/Menu Help
· launch a World Wide Web browser

Formatting Toolbar Provides functions to
· format paragraph styles
· specify font type and size
· apply bold, italic, and underline formats
· specify font and cell color
· align text to the left, center, and right
· create bulleted and numbered lists
· insert line breaks

Style Toolbar Provides advanced HTML formatting tags. This toolbar is not 
displayed when you launch CorelWEB.DESIGNER.

Forms Toolbar Provides functions to
· insert forms
· add standard HTML form elements including text fields, radio 

buttons, check boxes, submit and reset buttons, lists, and menus.

Applications Toolbar Provides access to each program contained in the 
CorelWEB.GRAPHICS SUITE.
· CorelWEB.MOVE
· CorelWEB.DRAW
· CorelWEB.WORLD
· CorelWEB.GALLERY
· CorelWEB.Transit

Status Bar Provides messages related to current operations and program 
status.

To determine the function of particular toolbar buttons, slowly pass your mouse over an unfamiliar icon. 
CorelWEB.DESIGNER displays a short "tool tip" description of the item, detailing its function. A more extensive 



description of the button's function appears in the CorelWEB.DESIGNER status bar at the bottom of the 
application window.

See Also
CorelWEB.DESIGNER menus
HTML tag reference



Formatting Toolbar buttons
HTML formatting options provided on the CorelWEB.DESIGNER Formatting toolbar include the following:

Icon Descriptio
n

Function or HTML Tag

N/A Paragraph 
Style 
Selection list 
box 

Specifies formatting for headings 
(corresponding to HTML tags <H1> 
through <H6>), preformatted blocks 
(<PRE> tag), and block quotations 
(<BLOCKQUOTE> tag).

N/A Font 
Selection list 
box 

Specifies a font typeface for displaying 
text, corresponding to the HTML <FONT 
FACE=> tag.

N/A Font Size 
Selection list 
box

Specifies the font size of selected text, 
corresponding to the <FONT SIZE=> 
tag. You can specify absolute or relative 
values for the size.

Bold Specifies the boldface attribute, 
corresponding to the <B> tag.

Italic Specifies the italics attribute, 
corresponding to the <I> tag.

Underline Specifies the underline attribute, 
corresponding to the <U> tag.

Font/Cell 
Color

Specifies a color attribute for text or 
table cell backgrounds.

Align Left Aligns the selected text or image to the 
left side of the page, corresponding to 
the <P ALIGN=LEFT> tag.

Align Center Centers the selected text or image, 
corresponding to the <P 
ALIGN=CENTER> attribute or 
<CENTER> and </CENTER> container 
tags in HTML.

Align Right Aligns the selected text or image to the 
right side of the page, corresponding to 
the <P ALIGN=RIGHT> tag.

Unordered 
List

Creates an unordered (bulleted) list from
selected paragraphs, corresponding to 
the use of the <UL> tag and the <LI> 
tag 

Ordered List Creates an ordered (numbered) list from
selected paragraphs, corresponding to 
the use of the <OL> tag and the <LI> 
tag 

Line Break Inserts a line break, corresponding to 
the HTML <BR> tag.

Note
· Some of the formatting options provided in WEB.DESIGNER's Formatting Toolbar are not supported by less 

sophisticated browsers, and may be ignored or distorted when displayed on the Web.

See Also



Using toolbars
HTML tag reference
Viewing and editing HTML Source



Style Toolbar buttons
The Style Toolbar provides the following advanced formatting options:

Icon Descripti
on

Function or HTML Tag

Strike-
through

Applies the strike-through attribute to 
selected text, corresponding to the 
<S> tag.

Typewritten
or Teletype

Applies the typewritten or teletype 
attribute to selected text, 
corresponding to the <TT> tag.

Emphasis Applies the emphasis attribute to 
selected text, corresponding to the 
<EM> tag.

Strong 
Emphasis

Applies the strong emphasis attribute 
to selected text, corresponding to the 
<STRONG> tag.

Inserted 
Text

Applies the inserted text attribute to 
selected text, corresponding to the 
<INS> tag.

Deleted 
Text

Applies the deleted text attribute to 
selected text, corresponding to the 
<DEL> tag.

Example 
Code

Applies the example code attribute to 
selected text, corresponding to the 
<CODE> tag.

Variable Applies the variable attribute to 
selected text, corresponding to the 
<VAR> tag.

Literal 
(Sample)

Applies the sample attribute to 
selected text, corresponding to the 
<SAMP> tag.

Typed Text Applies the keyboard or typed text 
attribute to selected text, 
corresponding to the <KBD> tag.

Citation Applies the citation attribute to 
selected text, corresponding to the 
<CITE> tag.

Short 
Quotation

Applies the short quotation attribute to 
selected text, corresponding to the 
<Q> tag.

Author Applies the author attribute to selected 
text, corresponding to the <AU> tag.

Surname or
Person

Applies the person attribute to selected
text, corresponding to the <PERSON> 
tag.

Term 
definition

Applies the term definition attribute to 
selected text, corresponding to the 
<DFN> tag.



Acronym Applies the acronym attribute to 
selected text, corresponding to the 
<ACRONYM> tag.

Abbreviatio
n

Applies the abbreviation attribute to 
selected text, corresponding to the 
<ABBREV> tag.

See Also
Using toolbars
HTML tag reference
Viewing and editing HTML Source



Forms Toolbar buttons
The Forms Toolbar provides the following options:

Toolba
r 
Icon

Form 
Eleme
nt

Description

Insert 
Form

Creates a new form, corresponding to the 
HTML <FORM> tag. You can also create a 
new form by clicking Insert, Form.

Text field Creates a new text field, corresponding to 
the HTML "text" <INPUT TYPE>. You can 
also create a new text field on a form by 
clicking Insert, Form Field Text Field.

Button Creates a new button, corresponding to 
either the HTML "submit" or "reset" <INPUT
TYPE>. You can also create a new button 
on a form by clicking Insert, Form Field 
Button.

Check 
Box

Creates a new check box field, 
corresponding to the HTML "checkbox" 
<INPUT TYPE>. You can also create a new 
check box field on a form by clicking Insert,
Form Field Check Box Field.

Radio 
button

Creates a new radio button, corresponding 
to the HTML "radio" <INPUT TYPE>. You can
also create a new radio button on a form by
clicking Insert, Form Field Radio Button.

Selectio
n list or 
menu

Creates a new selection list or menu, 
corresponding to the HTML <SELECT> tag. 
You can also create a new selection list or 
menu on a form by clicking Insert, Form 
Field List/Menu.

See Also
Using toolbars
Designing forms
Creating a new form
Adding elements to a form
HTML tag reference



Standard Toolbar buttons
Provides quick mouse access to some of the most common Windows functions, allowing you to view your Web 
page's structure, edit the HTML Source, create a hyperlink, insert images, format image maps, add a horizontal 
line, or use the WEB.DESIGNER context-sensitive help.
To enable or disable the Standard Toolbar, click View, Standard Toolbar. The Standard Toolbar provides the 
following options:

Icon Descripti
on

Function 

New Opens a new WEB.DESIGNER window.
Open Opens an existing Web page file.
Save Saves the current file.
Print Prints a WEB.DESIGNER file.
Spell Verifies all spelling in your 

WEB.DESIGNER document.
Find Locates a specified text string in your 

WEB.DESIGNER document.
Cut Removes selected data and puts it in 

the Clipboard.
Copy Copies selected data from your Web 

page to the Clipboard.
Paste Pastes data from the Clipboard into an 

open Web page.
Edit HTML Opens a new WEB.DESIGNER window, 

displaying the HTML code that 
corresponds to the current Web page.

Document 
Tree

Displays the hierarchical structure of 
HTML formatting tags within the Web 
page.

Hyperlink Formats the selected text as a 
hypertlink, corresponding to the HTML 
<A HREF=> tag.

Image Adds an image to your Web page.
Image Map 
Editor

Launches the Image Map Editor, 
allowing you to edit or create an image 
map file for a selected graphic.

Horizontal 
Rule

Inserts a horizontal rule.

Insert Table Opens the Table Properties dialog box, 
allowing you to add a table to your Web
page.

Browser 
Preview

Launches a Web browser directly from 
the WEB.DESIGNER window.

Screen/
Menu Help

Displays help for buttons, menu items, 
and window areas.

See Also
Using toolbars





Applications Toolbar buttons
Provides quick mouse access to all of the programs contained in the CorelWEB.GRAPHICS SUITE box. Choosing an
application logo from the Applications Toolbar, launches the corresponding program.
To enable or disable the Applications Toolbar, choose View, Applications Toolbar. Options provided by the 
applications buttons include

Icon Description Function
CorelWEB.MO
VE

Launches the CorelWEB.MOVE 
application from the 
WEB.DESIGNER window.

CorelWEB.DRA
W

Launches the CorelWEB.DRAW 
application from the 
WEB.DESIGNER window.

CorelWEB.WO
RLD

Launches the CorelWEB.WORLD 
application from the 
WEB.DESIGNER window.

CorelWEB.GAL
LERY

Launches the CorelWEB.GALLERY 
application from the 
WEB.DESIGNER window.

CorelWEB.Tra
nsit

Launches the CorelWEB.Transit 
application from the 
WEB.DESIGNER window.

Note
· Choosing an Applications Toolbar button launches the corresponding program without closing your 

WEB.DESIGNER window. This allows you to automatically merge work created in any other WEB.GRAPHICS 
SUITE application with your WEB.DESIGNER file, ultimately improving the quality and variety of your pages.

See Also
Publishing files to WEB.DESIGNER



Status bar

Displays command or toolbar functions at the bottom of the CorelWEB.DESIGNER window. To show or hide the 
status bar, click View, Status Bar.

CAP Indicates that the Caps Lock function is enabled.
NUM Indicates that the Num Lock function is enabled.
SCRL Indicates that the Scroll Lock function is enabled.



Spelling Check

Opens the Spell Check dialog box, allowing you to verify the spelling of all text in your WEB.DESIGNER document.



CorelWEB.Transit

Launches the CorelWEB.Transit application from your WEB.DESIGNER window. The CorelWEB.Transit application 
translates standard word processing files into HTML code. .HTML files can be automatically published to your 
CorelWEB.DESIGNER page.



CorelWEB.MOVE

Launches the CorelWEB.MOVE application from your WEB.DESIGNER window. The CorelWEB.MOVE application 
allows you to create animations and save them as animated GIFs or applets written in the Java Programming 
Language (TM). Animations can be automatically published back to WEB.DESIGNER.



CorelWEB.DRAW

Launches the CorelWEB.DRAW application from your WEB.DESIGNER window. The CorelWEB.DRAW application is 
an image creation program based on the award-winning DRAW illustration technology. Images can also be 
automatically published back to WEB.DESIGNER.



CorelWEB.WORLD

Launches the CorelWEB.WORLD application from your WEB.DESIGNER window. The CorelWEB.WORLD application
allows you to create exciting VRML files. VRML can also be automatically published back to WEB.DESIGNER.



CorelWEB.GALLERY

Launches the CorelWEB.GALLERY application from your WEB.DESIGNER window. CorelWEB.GALLERY provides 
over 7500 Internet-ready images in .GIF or .JPG formats. It contains backgrounds, buttons, bullets, separators, 
alphabets, icons, arrows, clipart, and photos. You can drag and drop WEB.GALLERY images directly onto your 
WEB.DESIGNER page.



Browser Preview 

Launches a Web browser directly from the WEB.DESIGNER window. To view your documents as they will appear 
to your visitors on the World Wide Web, you must first set a default browser by clicking Tools, Set Browser and 
locating a viewing device. To open a current WEB.DESIGNER document in the specified browser, click Tools, 
Browser Preview. To view Web pages that contain embedded files such as applets or VRML, you must download 
the appropriate plug-in applications for your browser. 



Set Browser

Opens the Select HTML Browser dialog box, allowing you to select a browser for previewing your WEB.DESIGNER 
documents. The first time you access the Set Browser command, you must locate the browser that you wish to 
launch. Choose Tools, Browser Preview to launch the specified browser directly from the WEB.DESIGNER window. 
To change your default specification, click Tools, Set Browser and type the directory path to a new viewing 
device. To view Web pages that contain embedded files such as applets or VRML, you must download the 
appropriate plug-in applications for your browser. 



Set Server Root 

Identifies the server root directory where you will store your WEB.DESIGNER pages and referenced files. The 
server root directory provides a base location for relative URLs to images and other .HTML files. After changing 
your server root directory, restart WEB.DESIGNER to fix the settings.



Options

Opens the Options dialog box, allowing you to enable or disable the welcome on startup message, the 
application launch messages, WEB.DRAW's image transparency option, and the lower case file name command. 



Options dialog box
Enables or disables the welcome on startup message, the application launch messages, and the WEB.DRAW 
transparency option. 

Display welcome screen on startup
Enables or disables the appearance of the welcome screen on startup. The welcome screen gives you the option 
to start a new Web page, open an existing Web page, or choose a template to begin a Web page.

Display application startup screens
Enables or disables the appearance of the application startup screens when you launch another 
CorelWEB.GRAPHICS SUITE program from the WEB.DESIGNER window.

Enable transparency when publishing from WEB.DRAW
Enables or disables the appearance of transparent GIF images when you publish a drawing created in the 
CorelWEB.DRAW application. Transparency removes a GIF image's background color from the graphics file, so 
that when displayed, the browser's background color shows through the image. If you publish a CorelWEB.DRAW 
image to WEB.DESIGNER with the transparency command enabled, your image appears to float on the 
WEB.DESIGNER page. If you publish a CorelWEB.DRAW image to WEB.DESIGNER with the transparency command
disabled, the image's original background color overrides the browser's background shade. CorelWEB.DESIGNER 
defaults to the transparent setting.

Enable lower case file names
Allows all referenced files in your HTML documents to appear in lowercase letters when you click Browse in an 
application dialog box. By default, WEB.DESIGNER disables this option.
Notes
· The Enable transparency when publishing from WEB.DRAW command applies exclusively to WEB.DRAW 

images. WEB.DESIGNER displays all other GIF images according to their individual properties (transparent or 
plain).

· If you ftp your WEB.DESIGNER documents to your UNIX server or service provider without enabling the lower 
case file name option, your ftp application may transfer the files in lowercase regardless of the actual DOS 
case referenced throughout your documents. Because UNIX systems maintain case sensitivity, the files 
referenced in links and images throughout your WEB.DESIGNER pages are not displayed accurately on the 
Web. 



Split

Transforms your mouse pointer to a horizontal bar that divides your WEB.DESIGNER screen into two adjustable 
panes. Left-click or press ENTER [key] to fix the window display at the preferred location. To remove the split, 
click View, Split and drag the horizontal bar to the top of your WEB.DESIGNER screen.



New Window

Opens a new CorelWEB.DESIGNER window, allowing you to view multiple WEB.DESIGNER pages simultaneously.



Document Tree

Displays the hierarchical structure of the HTML formatting tags that code a current Web page. Expand or collapse
the display of embedded tags in the Document Tree by clicking the  or 
 key next to the appropriate code. To edit the HTML code for a current Web page, click Edit, HTML Source.

Expands the HTML entries, 
displaying all embedded text, 
objects, and HTML tags.
Collapses the HMTL entries, 
displaying only the main formatting
code for the current Web page.

Standard Toolbar

Shows or hides the Standard toolbar in the current WEB.DESIGNER window.



Formatting Toolbar

Shows or hides the Formatting toolbar in the current WEB.DESIGNER window.



Style Toolbar

Shows or hides the Style toolbar in the current WEB.DESIGNER window.



Forms Toolbar

Shows or hides the Forms toolbar in the current WEB.DESIGNER window.



Applications Toolbar

Shows or hides the Applications toolbar in the current WEB.DESIGNER window.



Status Bar

Shows or hides the Status bar allowing you to display the function of a WEB.DESIGNER menu command or 
toolbar button.



Refresh Window

Redraws the WEB.DESIGNER screen according to your latest specifications. Choose View, Refresh Window if any 
distortion occurs when updating a document or if your changes do not immediately take effect.



Bookmarks

Marks all bookmarks in your current WEB.DESIGNER document with a color that you choose from the Page 
Properties dialog box in the File menu. The bookmark color specification will not show up in a browser window 
and can be toggled on or off with the Bookmarks command in the View menu. The default bookmark 
identification color is red.



Setting up a browser
Before previewing your WEB.DESIGNER pages for the first time, you must specify a browser using the Set 
Browser command in the WEB.DESIGNER Tools menu. WEB.DESIGNER sets your selection as the default for all 
subsequent previews. You can use the browser to preview your Web pages as you create them or to view pages 
already published on the World Wide Web.

To set up a browser
1. Click Tools, Set Browser.

WEB.DESIGNER opens the Select HTML Browser dialog box.
2. Type a directory path leading to your browser's .EXE file or click Browse to locate the file on your system.
3. Click OK.
Notes
· To launch the specified browser directly from the WEB.DESIGNER window, click Tools, Browser Preview or click

.
· To change your default specification, click Tools, Set Browser and type the directory path to a new browser.
· To view Web pages that contain embedded files such as applets or VRML, you must download the 
appropriate plug-in applications for your browser. Netscape plug-ins are available at 
http://home.netscape.com/comprod/mirror/navcomponents_download.html. You can also go to the 
Netscape home page at http://home.netscape.com and follow the links to the plug-in page. Microsoft plug-ins are
available at http://www.microsoft.com/ie/addons/default.htm or by following links from the Microsoft home 
page at http://www.microsoft.com.
· Java (TM) applets will not appear in Windows 3.1 systems. To view the applets, copy all associated .CLASS files 

to their appropriate directories after moving the applet to a server that supports long file names.

See Also
Tools menu
Viewing VRML
Viewing your Web pages
Troubleshooting techniques



Viewing your Web pages
One of the most important steps in the Web creation process, is previewing. Although you can view your Web 
page in the WEB.DESIGNER window as you are creating it, viewing the document as it appears on the World Wide
Web reveals exactly what your visitors encounter when they enter your site. Previewing Web documents with a 
browser, stems from the days when all Web pages were constructed in HTML code and the finished product could
only be viewed using a Web browser. Today, with advanced WYSIWYG editors like CorelWEB.DESIGNER, 
previewing uncovers the minor alterations in color, font, or format that your visitors will experience on the Web.

To view your WEB.DESIGNER page from a browser window

· Click Tools, Browser Preview or click  to open your current document in a browser window.
Notes
· The first time you select the Browser Preview command, you must specify the location of your browser's .EXE 

file.
· If you embed files in your WEB.DESIGNER pages, you may require additional applications to view your site. In 

these cases, you must set the Set Browser command to open a viewer that supports plug-ins (e.g., Netscape 
2.0, or Internet Explorer), and download the appropriate add-on.

· You can change the browser default setting by clicking Browse on the Select HTML browser dialog box and 
locating the executable file of another viewer.

· Avoid running multiple copies of your Web browser by closing the application each time you preview. If you 
choose to leave your browser open, simply save your file in WEB.DESIGNER and press the Reload button on 
your browser's toolbar to display the most recent version of your Web page.

See Also
Tools menu
Viewing VRML
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Viewing Barista files in a browser
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Viewing VRML
To view some of CorelWEB.DESIGNER's more advanced integration and merging operations, visitors to your site 
may require specialized display mechanisms and addon viewing components. For example, to view a virtual 
world that you have published in your WEB.DESIGNER page, visitors must access your site with an advanced 
browser such as Netscape Navigator 3.0 or Netscape Navigator 2.0 accompanied by plug-in applications. A plug-
in is an attachment to an Internet browser that enables the browser to display file formats other than .HTML.
Viewing .WRL files in your WEB.DESIGNER pages
.WRL files conform to the VRML 1.0 standard used by the most popular viewers (such as Netscape 2.0) that have 
a 3D plug-in. Viewing .WRL files through a browser allows visitors to navigate your world viewing all of the paints,
wallpapers, pictures, and links to URLs. Standard viewers do not support the ability to view albums, attached 
text, sounds, walking shows, background MIDI music, or moving wallpaper. The only function supported by the 
VRML standard is Link to URL. The background color for your world becomes the sky color.
If you publish the .WRL copy of your file, you can direct visitors to the Netscape Internet site to download 
Netscape's VRML plug-in for Netscape 2.0, Live3D. The Netscape Internet site resides at 
http://home.netscape.com/comprod/mirror/navcomponents_download.html or may be located by 
following links from the Netscape home page at http://home.netscape.com. Live3D is built into Netscape 3.0 
so visitors to your site using this version do not require addon applications.
You can find the Internet Explorer 2.0 plug-in at http://www.microsoft.com/ie/addon/vrml.htm or by 
accessing the Software library from the Microsoft home page at http://www.microsoft.com. Microsoft's 
Internet Explorer 3.0 has built-in VRML support.
Notes
· To integrate CorelWEB.WORLD .MUS files with your Web page, you must create a standard hypertext link in 

your WEB.DESIGNER document that points to the .MUS file.
· To avoid directing visitors to another site to download a plug-in or viewer, you can include a copy of the 

WEB.WORLD viewer, which is freely distributable, with the .MUS copy of your file. Enable the Copy the Viewer 
box when you publish to VRML. This includes a copy of the WEB.WORLD viewer in the directory to which all of 
your other files are saved. Compress the directory into a self-extracting archive and create a single hypertext 
link from your page to the WEB.WORLD file.

· To view .MUS files in Netscape, on a Windows 95 or NT system, download the Netscape plug-in from Corel's 
downloading site at http://www.corel.com/corelweb/webgraphics/viewers. The CorelWEB.WORLD Viewer file 
can also be downloaded from this location.

See Also
Inserting VRML
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Exploring the Welcome to CorelWEB.DESIGNER message
You can start a new Web page, open an existing Web page, or choose a template to begin a Web page with the 
Welcome to CorelWEB.DESIGNER message. For information about the Welcome to CorelWEB.DESIGNER screen 
elements, click the appropriate areas of the following illustration:

See Also
Exploring the CorelWEB.DESIGNER screen
Creating new Web pages
Re-enabling the Welcome to CorelWEB.DESIGNER screen



Start a new Web page

Removes the Welcome to CorelWEB.DESIGNER message and opens a new, blank page in the WEB.DESIGNER 
window.



Open an existing Web page

Opens your server root directory in the Open dialog box, allowing you to access and edit an .HTML document 
that you have saved on your local system.



Choose a template to begin your Web page

Opens CorelWEB.DESIGNER's Template dialog box, allowing you to edit a pre-designed HTML page in the 
WEB.DESIGNER window.



Display this screen at startup

Enables or disables the display of the Welcome to CorelWEB.DESIGNER screen when you launch the application. 
By default, WEB.DESIGNER enables this command.



Exploring the CorelWEB.DESIGNER screen
WEB.DESIGNER presents over 85 menu commands with almost 60 complimentary toolbar options to simplify the 
creation of even the most complex hyperdocuments. For information about any WEB.DESIGNER screen element, 
click the appropriate area of the following illustration:

See Also
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Title bar

Repositions CorelWEB.DESIGNER's main window on your computer screen. The title bar also displays the name of
the active document, the system menu commands, and the Windows 95 control buttons.



System menu

Controls the appearance and status of the WEB.DESIGNER application window. Click the WEB.DESIGNER system 
icon on the application's title bar to restore, move, size, minimize, maximize, or close the WEB.DESIGNER 
window.



Control buttons

Provide one-click access to the minimize, maximize, and close commands, allowing you to collapse, expand, or 
exit the WEB.DESIGNER application window.



File menu

Provides standard Windows menu commands for creating new files, opening existing documents, setting page 
properties, saving or printing your work, and exiting the application.



Edit menu

Provides standard Windows menu commands for undoing and redoing actions, cutting, copying, and pasting text,
selecting, finding, and replacing objects, editing properties, and modifying your document's HTML Source code 



View menu

Provides menu commands for splitting and refreshing windows, opening a new window, displaying the document 
tree, displaying toolbars in the CorelWEB.DESIGNER window, and enabling/disabling the CorelWEB.DESIGNER 
bookmark display.



Insert menu

Provides menu commands for adding HTML elements and files to the currently open Web page. These commands
include inserting forms and form fields, adding images, horizontal rules, paragraphs, and line breaks, adding 
applets written in the Java (TM) Programming Language, merging .HTML files, embedding Internet files, and 
creating ordered and unordered lists.



Format menu

Provides menu commands for formatting headings, ordered and unordered lists, bookmarks, and hyperlinks in 
HTML.



Table menu

Provides menu commands used to add HTML tables to an active Web page. These commands allow you to insert 
and delete tables, cells, rows, or columns, select table attributes, and modify standard table properties.



Tools menu

Provides menu commands for organizing your documents. These commands allow you to check your completed 
documents for spelling errors, accessing the other CorelWEB.GRAPHICS SUITE applications, set up a server root 
directory, specify a browser, preview your Web pages, and enable the Welcome on startup message.



Help menu

Provides standard Windows menu commands for accessing all online help topics. You can search for specific help
topics, activate the screen/menu help or WEB.DESIGNER tutorial, browse through the contents page, or access 
the WEB.GRAPHICS SUITE Web Page.



Paragraph style

Specifies formatting for headings, preformatted text, and block quotations.



Font selection

Specifies a font to apply to selected text.



Font size

Specifies the size of selected text. You can set absolute or relative values for the font size.



Bold

Applies the boldface attribute to selected text.



Italic

Applies the italics attribute to selected text.



Underline

Applies the underline attribute to selected text.



Font/cell color

Adds color to text or table cell backgrounds.



Align left

Aligns the selected text or image to the left side of the page.



Center

Centers the selected text or image.



Align right

Aligns the selected text or image to the right side of the page.



Unordered list

Formats selected paragraphs in an unordered (bulleted) list.



Ordered list

Formats selected paragraphs in an ordered (numbered) list.



Line break

Inserts a line break.



Strike-through

Applies the Strike-through style to selected text.



Teletype

Applies the Typewritten or Teletype style to selected text.



Emphasis

Applies the Emphasis style to selected text.



Strong emphasis

Applies the Strong Emphasis style to selected text.



Inserted text

Applies the Inserted Text style to selected text.



Deleted text

Applies the Deleted Text style to selected text.



Example code

Applies the Example Code style to selected text.



Variable

Applies the Variable style to selected text.



Literal (sample)

Applies the Sample style to selected text.



Typed text

Applies the Keyboard or Typed Text style to selected text.



Citation

Applies the Citation style to selected text.



Short quotation

Applies the Short Quotation style to selected text.



Author

Applies the Author style to selected text.



Surname (Person)

Applies the Person style to selected text.



Term definition

Applies the Term Definition style to selected text.



Acronym

Applies the Acronym style to selected text.



Abbreviation

Applies the Abbreviation style to selected text.



New

Opens a new WEB.DESIGNER window.



Open

Allows you to open an existing Web page.



Save

Saves the active file.



Print

Prints a WEB.DESIGNER file.



Spell

Verifies all spelling in your active document.



Find

Locates a specified text string in your active document.



Cut

Removes selected data and copies it to the Windows Clipboard.



Copy

Copies selected data from your Web page into the Windows Clipboard.



Paste

Pastes data from the Windows Clipboard into an open Web page.



Edit HTML

Opens a new WEB.DESIGNER window, displaying the HTML code that corresponds to the active Web page.



Document tree

Displays the hierarchical structure of HTML formatting tags within the active page.



Hyperlink

Allows you to format the selected text or image as a hyperlink.



Image

Allows you to add an image to your Web page.



Image map editor

Launches the Image Map Editor, allowing you to edit or create an image map file.



Horizontal rule

Inserts a horizontal rule.



Insert table

Opens the Table Properties dialog box, allowing you to add a table to your active page.



Browser preview

Launches a Web browser directly from the WEB.DESIGNER window.



Screen/menu help

Displays help for buttons, menu items, and window areas.



Insert form

Opens the Form Properties dialog box, allowing you to add a form to your Web page. You can also create a form 
by clicking Insert, Form.



Text field

Adds a text field to your form. You can also add a text field by clicking Insert, Form Field, Text Field.



Button

Adds a button to your form. You can also add a button by clicking Insert, Form Field, Button.



Check box

Adds a check box field to your form. You can also add a check box field by clicking Insert, Form Field, Check Box 
Field.



Radio button

Adds a radio button to your form. You can also add a radio button by clicking Insert, Form Field, Radio Button.



Selection list/menu

Adds a selection list or menu to your form. You can also add a selection list or menu by clicking Insert, Form 
Field, List/Menu.



CorelWEB.MOVE

Launches the CorelWEB.MOVE application from the WEB.DESIGNER window.



CorelWEB.DRAW

Launches the CorelWEB.DRAW application from the WEB.DESIGNER window.



CorelWEB.WORLD

Launches the CorelWEB.WORLD application from the WEB.DESIGNER window.



CorelWEB.GALLERY

Launches the CorelWEB.GALLERY application from the WEB.DESIGNER window.



CorelWEB.Transit

Launches the CorelWEB.Transit application from the WEB.DESIGNER window.



Text area

Displays the structure and layout of your active Web page.



Status bar

Displays command or toolbar functions at the bottom of the CorelWEB.DESIGNER window. To show or hide the 
status bar, click View, Status Bar.
CAP Indicates that the Caps Lock function is enabled.
NUM Indicates that the Num Lock function is enabled.
SCRL Indicates that the Scroll Lock function is enabled.



Horizontal and vertical scroll bars

Display areas of your WEB.DESIGNER document that extend beyond the boundaries of your computer screen. 
Scroll arrows sit at the end of both the horizontal and vertical scroll bars and point in the direction that the 
window moves when you press each arrow. For rapid scrolling left, right, up, or down, click and hold the 
appropriate scroll arrow button.



CorelWEB.DESIGNER screen tour
To create Web pages that attract audiences and optimize WEB.DESIGNER's advanced capabilities, you should 
first explore the Welcome to WEB.DESIGNER message and the main application window. A clear understanding of
the commands and features presented in these windows simplifies the Web design process and eliminates 
uncertainty.

Exploring the Welcome to CorelWEB.DESIGNER message
Exploring the CorelWEB.DESIGNER application window
See Also
CorelWEB.DESIGNER basics
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Tips and tricks
Using CorelWEB.DESIGNER
Glossary of terms



Troubleshooting techniques
Enable lower case file names

The Enable lower case file names check box allows all referenced files in your HTML documents to appear in 
lowercase letters when you click Browse in an application dialog box. By default, WEB.DESIGNER disables this 
option.
If you ftp your WEB.DESIGNER documents to your UNIX server or service provider without enabling the lower 
case file name option, your ftp application may transfer the files in lowercase regardless of the actual DOS case 
referenced throughout your documents. Because UNIX systems maintain case sensitivity, the files referenced in 
links and images throughout your WEB.DESIGNER pages are not displayed accurately on the Web. 

Problem:
Your files look fine locally but when placed on a UNIX server, the referenced images and links are broken.

Solution:
Click Tools, Options and enable the lower case file name check box before creating your WEB.DESIGNER 
documents. If the Enable lower case file names option is enabled, WEB.DESIGNER references all files in lower 
case to comply with .ftp standards. The source code for a referenced image will look something like this:
<IMG SRC="images\filename.gif">
If the Enable lower case file names option is disabled, WEB.DESIGNER determines the actual DOS case of all 
referenced files and the source code for the image could look like this:
<IMG SRD="images\Filename.gif">
<IMG SRC="images\FileName.gif">
<IMG SRC="images\FIlename.gif">
Although DOS systems recognize each of these files as the same image, UNIX systems recognize three 
completely different files and will not display an accurate representation of the image on the Web.
Note
· The DOS case of files generated by Windows 95 is not the same as the case displayed in your Explorer 

directories but the DOS case of files generated by Windows NT 3.51 systems is the same as the File Manager 
case. The DOS case of files generated by Windows 3.1x systems is upper case.
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